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Preface

About This Manual

This document describes Release 4.2 of both Rational ClearCase configuration management

software and Rational ClearCase MultiSite software for the Windows 98, Windows Me,

Windows NT, and Windows 2000 operating systems.
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Typographical Conventions

This manual uses the following typographical conventions:

➤ ccase-home-dir represents the directory into which the ClearCase Product Family has been

installed. By default, this directory is /usr/atria on UNIX and

C:\Program Files\Rational\ClearCase on Windows.

➤ attache-home-dir represents the directory into which ClearCase Attache has been installed.

By default, this directory is C:\Program Files\Rational\Attache, except on Windows 3.x,

where it is C:\RATIONAL\ATTACHE.

➤ Bold is used for names the user can enter; for example, all command names, file names, and

branch names.

➤ Italic is used for variables, document titles, glossary terms, and emphasis.

➤ A monospaced font is used for examples. Where user input needs to be distinguished

from program output, bold is used for user input.

➤ Nonprinting characters are in small caps and appear as follows: <EOF>, <NL>.

➤ Key names and key combinations are capitalized and appear as follows: SHIFT, CTRL+G.

➤ [ ] Brackets enclose optional items in format and syntax descriptions.

➤ { } Braces enclose a list from which you must choose an item in format and syntax

descriptions.

➤ |  A vertical bar separates items in a list of choices.

➤ ... In a syntax description, an ellipsis indicates you can repeat the preceding item or line

one or more times. Otherwise, it can indicate omitted information.

NOTE: In certain contexts, ClearCase recognizes “...” within a pathname as a wildcard, similar

to “*” or “?”. See the wildcards_ccase reference page for more information.

➤ If a command or option name has a short form, a “medial dot” ( ⋅ ) character indicates the

shortest legal abbreviation. For example:

lsc·heckout

This means that you can truncate the command name to lsc or any of its intermediate

spellings (lsch, lsche, lschec, and so on).
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Online Documentation

The ClearCase graphical interface includes a standard Windows help system.

There are three basic ways to access the online help system: the Help menu, the Help button, or

the F1 key. Help>Help Topics provides access to the complete set of ClearCase online

documentation. For help on a particular context, press F1. Use the Help button on various dialog

boxes to get information specific to that dialog box.

ClearCase also provides access to full “reference pages” (detailed descriptions of ClearCase

commands, utilities, and data structures) with the cleartool man subcommand. Without any

argument, cleartool man displays the cleartool overview reference page. Specifying a command

name as an argument gives information about using the specified command. For example:

> cleartool man (display the cleartool overview page)

> cleartool man man (display the cleartool man reference page)

> cleartool man checkout (display the cleartool checkout reference page)

ClearCase’s –help command option or help command displays individual subcommand syntax.

Without any argument, cleartool help displays the syntax for all cleartool commands. help
checkout and checkout –help are equivalent.

> cleartool uncheckout –help
Usage: uncheckout | unco [-keep | -rm] [-cact | -cwork ] pname ...

Additionally, the online ClearCase Tutorial provides important information on setting up a user’s

environment, along with a step-by-step tour through ClearCase’s most important features. To

start the ClearCase Tutorial, choose Tutorial in the ClearCase folder off the Start menu.
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Technical Support

If you have any problems with the software or documentation, please contact Rational Technical

Support via telephone, fax, or electronic mail as described below. For information regarding

support hours, languages spoken, or other support information, click the Technical Support link

on the Rational Web site at www.rational.com.

Your Location Telephone Facsimile Electronic Mail

North America 800-433-5444

toll free or

408-863-4000

Cupertino, CA

408-863-4194

Cupertino, CA

781-676-2460

Lexington, MA

support@rational.com

Europe, Middle

East, and Africa

+31-(0)20-4546-200

Netherlands

+31-(0)20-4546-201

Netherlands

support@europe.rational.com

Asia Pacific 61-2-9419-0111

Australia

61-2-9419-0123

Australia

support@apac.rational.com
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11 READ ME FIRST

This chapter describes important information in this release. Read it before you attempt to install

Rational ClearCase or Rational ClearCase MultiSite.

NOTE: The term CPF stands for ClearCase Product Family and refers to the products ClearCase,

Attache, and MultiSite. ClearGuide is not included in Release 4.2. The term 3.x refers to 3.2.1 and

the term 4.x refers to 4.0, 4.1, and 4.2.

1.1 Supported Architectures

ClearCase and MultiSite Release 4.2 run on the platforms listed in Table 1.

Table 1 Supported Platforms for ClearCase and MultiSite in Release 4.2

Hardware platform Operating system

Intel x86 Windows NT 4.0 SP4, 4.0 SP5, and 4.0 SP6a

Windows 2000 SP1

Windows 98 all versions (client only)1

Windows Me (client only)1

1. Rational ClearCase 4.2 clients support the latest Windows 2000, Windows NT, Windows Me, and
Windows 98 releases.
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This release of ClearCase does not include support for Windows 95. Customers who require

support for Windows 95 must run an earlier version of ClearCase (4.1) or upgrade their

Windows 95 clients to at least Windows 98 or Windows Me.

For more information about differences in features and functionality by platform, see the

ClearCase Platform-Specific Guide.

1.2 Supported File Systems

Table 2 lists the file systems that ClearCase supports. If a file system does not appear on the list,

it is not supported. Please inform Rational Technical Support or your sales representative of any

concerns you have about this list.

Windows/UNIX Interoperation

This section provides information about ClearCase support for file access between Windows and

UNIX platforms, as it pertains to Release 4.2. As of this release, ClearCase supports these

Windows/UNIX interoperation solutions:

➤ ClearCase File Server

➤ Third-party NFS client products

➤ Third-party SMB server products

Table 2 Supported File Systems by Platform

Platform Supported file systems

Windows NT FAT, NTFS, LANMAN, NFS1

Windows 98 FAT, FAT32

Windows Me FAT, FAT32, LANMAN

Windows 2000 FAT, FAT32, NTFS, LANMAN

1. See Table 3 for more information on NFS platforms
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For more information about ClearCase support of these products, see Administering ClearCase.

For the most recent information about ClearCase Windows and UNIX interoperation, see the

Rational ClearCase Web site, clearcase.rational.com.

ClearCase File Server (CCFS)

ClearCase clients on Windows NT, Windows 2000, Windows Me, and Windows 98 that use

snapshot views can access files in UNIX VOBs using the ClearCase File Server (CCFS). In

addition, UNIX clients using snapshot views can access files in Windows VOBs using CCFS. If a

host uses only snapshot views and is configured to use CCFS, ClearCase does not require

third-party NFS or SMB products to access UNIX or Windows VOBs.

NOTE: CCFS does not support dynamic views.

On Windows NT and Windows 2000, CCFS is disabled by default for ClearCase clients and

servers. On Windows 98 and Windows Me, CCFS is enabled by default for ClearCase clients.

For more information about CCFS, see Administering ClearCase.

Third-Party NFS Client Products

ClearCase hosts on Windows NT can access UNIX VOBs and views using an NFS client for

Windows NT product. To use NFS, you must install one of the products listed in Table 3 on each

ClearCase for Windows NT host from which you want to access a UNIX VOB or view.

Table 3 Supported NFS Client Products for Windows

Product Supported product versions

Hummingbird NFS Maestro 7.0.0.1 (recommended for Release 4.x of

ClearCase on Windows NT and Windows

2000)

Shaffer Solutions Corporation DiskAccess 5.0 or later

Microsoft Windows NT Services for UNIX

(SFU) Add-On Pack (NFS Client)

Version SFU 1.0 only, at this time.

For Windows NT 4.0

For Windows 2000

For Windows Me
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Syntax TotalNET Advanced Server SMB Server Product

Windows NT hosts can use an SMB server product to access UNIX VOBs and views. To use SMB,

you must install one of the products listed in Table 2 on each UNIX server host from which you

want to access a UNIX VOB or view.

See the Rational Web site (clearcase.rational.com) for current Windows and UNIX interoperation

partner information.

For more information about SAMBA or TAS, see Administering ClearCase.

1.3 Hardware and Software Requirements

This section describes other software and hardware requirements for running ClearCase and

MultiSite.

Basic Software Requirements

ClearCase requires the following software on Windows NT, or Windows 2000:

➤ Windows Workstation or Windows Server

➤ TCP/IP (shipped with Windows NT 4.0, Windows Me, and Windows 2000)

Table 4 Supported SMB Server Products for Windows NT

Product Platform Supported product versions

Syntax TotalNET Advanced

Server (TAS)

Solaris 2.6 or later 5.2 (Patch 10), 5.3 (Patch 3), or

5.4.1 patch 3; 6.0 or later

HP-UX 11.0 or later 5.4.1 patch 3; 6.0 or later

AIX 4.3.2 and above TAS 6.0

SAMBA (available from

www.samba.org)

Solaris 8 or later SAMBA 2.0.7
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➤ Internet Explorer 4.0.1 SP1 or later; note that this does not have to be the default browser,

but is required for use of some ClearCase features, including the ClearCase Explorer, the

HTML Diff Merge tool, the ClearCase Automation Library (CAL), and the ClearCase

Administration Console.

➤ If acting as a ClearCase Web server: Web server software, either Apache (1.3.6 or later),

Netscape Enterprise (3.5.1 or later), or Microsoft Internet Information Server (IIS 4.0 or 5.0).

➤ If acting as a server for the ClearCase integrations with FrontPage 98, FrontPage 2000,

Visual InterDev, IIS Web server software and the FrontPage Server Extensions (FPSE).

➤ An Adobe Acrobat Reader, version 3 or later, to access the online manuals, which are PDF

files.

➤ On any system accessing ClearCase through the Web interface, a Web browser; either

Netscape 4 (version 4.6 or later) or Internet Explorer 4.0.1 (SP 1) or later. Netscape 6 is not

supported. (Note that it is not necessary to install ClearCase on such a system.)

ClearCase requires the following software on Windows 98 and Windows Me:

➤ Client for Microsoft Networks (shipped with Windows 98 and Windows Me)

➤ TCP/IP (shipped with Windows 98 and Windows Me)

➤ Windows Sockets 2 (shipped with Windows 98 and Windows Me)

➤ Internet Explorer 4.0.1 SP1 or later; note that this does not have to be the default browser,

but is required for use by some ClearCase features, including the ClearCase Explorer, the

HTML Diff Merge tool, and the ClearCase Automation Library (CAL).

➤ An Adobe Acrobat Reader, release 3 or later, to access the online manuals, which are PDF

files.

➤ On any system accessing ClearCase through the Web interface, a Web browser; either

Netscape 4.6 or later (but before Netscape 6.0), or Internet Explorer 4.0.1 (SP 1) or later.

(Note that it is not necessary to install ClearCase on such a system.)
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Disk Space Requirements for the Release Area

The file system of the networkwide release host must have sufficient disk space to hold the release

area:

Disk Space Requirements for Individual Hosts

Table 5 shows the approximate disk space requirements for a new installation of ClearCase.

These figures are for ClearCase files and upgraded system files only. In addition to the

requirements below, the installation needs 15 MB of temporary disk space.

In addition, any host that will have snapshot view directories needs enough disk space to contain

all files loaded into the snapshot views and all view-private files added to the views. The amount

of space required depends on the number and sizes of the files in the views.

Any host that will have VOB- or view-storage directories needs enough disk space to contain the

files and databases used for storage. The amount of space required depends on the characteristics

and use of the VOBs and views.

Windows NT

Windows 2000

128 MB

128 MB

Table 5 Disk Space Required for ClearCase Files and Upgraded System Files

ClearCase installation type
Disk space
required

Windows 98 and Windows Me client 70 MB

Windows NT and Windows 2000 client or server using standard

installation with dynamic views (5 MB for dynamic views), local VOBs,

and local views

120 MB

Windows NT and Windows 2000 client or server with all optional

components

135 MB
6 ClearCase and MultiSite Release Notes



1.4 Platform-Specific Information Relating to Installation

This section provides information that varies from platform to platform. ClearCase Product Family
Installation Notes specifically indicate when you will need this information and defines the terms

used in this section.

Web Site of Operating System Vendors

You can find up-to-date information on Microsoft Windows operating system issues at the

Microsoft Web site www.microsoft.com.

1.5 ClearCase and MultiSite Patches Incorporated in This Release

ClearCase Release 4.2 and MultiSite Release 4.2 include all the patches listed in Table 6. If you are

using a more recent patch on any of the patch streams listed, contact Rational Technical Support

to see whether there is a corresponding patch for Release 4.2.

1.6 Upgrading from a Previous Release

If you have a version of ClearCase prior to Release 3.0 installed, you cannot upgrade directly to

Release 4.2.

Table 6 ClearCase and MultiSite Patches Incorporated into This Release

Patch stream Last patch incorporated into this release

ClearCase v3.2.1 clearcase_p3.2.1.NT-33 and earlier

ClearCase v4.0 clearcase_p4.0.NT-21 and earlier

ClearCase v4.1 clearcase_p4.1NT-15 and earlier

MultiSite v3.2.1 multisite_p3.2.1.NT-8 and earlier

MultiSite v4.0 multisite_p4.0.NT-4 and earlier

MultiSite v4.1 multisite_p4.1.NT-3 and earlier
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To upgrade to Release 3.x, see the 3.x ClearCase and MultiSite Release Notes.

Upgrading to Release 4.2 does not require reformatting your VOBs, unless you are installing

with the newer VOB format (schema 54). For more information on general VOB database

structure, and for details on reformatting a VOB, see Administering ClearCase. Also, see the

reformatvob reference page.

Upgrading to Release 4.2 from a release prior to 4.1 does require upgrading your storage

locations; Release 4.1 added enhanced support for creating and managing storage locations. For

details, see the section Upgrading Storage Locations.

General Issues with Upgrading

ClearCase Product Family Installation Notes provides information necessary to install the ClearCase

family of products. Here is some general information to keep in mind about upgrading:

➤ Make sure that all views and VOBs are fully backed up. For information on backing up

VOBs and views, see Administering ClearCase.

➤ You do not need to upgrade your license server or get new ClearCase licenses. Licenses

work with any version of ClearCase product family software, and ClearCase 4.2 hosts can

use a ClearCase license server running a 3.x version of the software.

➤ Be sure that VOB and view servers are upgraded before you upgrade client hosts; Release

4.x clients cannot access VOBs or views on hosts that are running a pre-3.x release of

ClearCase.

➤ Updating your VOBs to use the latest VOB database schema—schema 54—requires that

you reformat them. We recommend updating your VOB database schema only if your site

clearly needs support for greater than 16 million records and VOB database file sizes greater

than 2GB, or the improved user ID representation provided by SIDs. The installation

procedure provides more information on this topic.

CAUTION: If you use MultiSite and update one or more replicas in a VOB family to the new

format, you must update all other replicas in the family before the reformatted replicas

exceed the database limit of the previous schema (53). If you do not, synchronization imports

will fail at any replica that has not been updated.

➤ If you have modified any files in ccase-home-dir (C:\Program Files\Rational\ClearCase, by

default), move them; if you do not, they will be lost when you install.
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➤ You need not remove the previous version of ClearCase unless you want to change the

location of your ClearCase installation directory.

CAUTION: If you are upgrading from Release 3.x and use the MultiSite synchronization

scripts in directory ccase-home-dir\config\cron, you must move these scripts to another

location before deinstalling. After installing Release 4.2, create the directory

ccase-home-dir\config\cron and move the scripts into that directory. For information on

switching to the MultiSite scripts provided with Release 4.2, see Converting to New MultiSite
Scripts and New ClearCase Scheduler on page 84.

See also Known Issues Related to Installation on page 16.

Evaluating This Release of ClearCase

The way in which you evaluate Release 4.2 depends on which release of ClearCase you are

currently running.

If you are running a release prior to 4.x and you want to evaluate Release 4.2, you can install

Release 4.2 on one or more test systems in your existing environment of servers, clients, views,

and VOBs and configure the test systems to use your 4.x license server.

If you are running Release 3.x and you want to evaluate Release 4.2 without disrupting your

existing environment, you can install Release 4.2 on one or more test systems and configure the

test systems to use your 3.x license server. You must configure one of the test systems as a

ClearCase registry server. Then configure the other test systems to use that server as their

ClearCase registry server. After this, you can create your views and VOBs on the test systems.

Alternatively, you can install Release 4.2 in evaluation mode on a test system. For more

information on evaluation mode, see the manual ClearCase Product Family Installation Notes.

Feature Compatibility Issues Across Releases

Even the simplest ClearCase operation invokes a communications chain that can involve several

components. For example, the act of checking out a file element involves a client program

(running on the developer’s workstation), which acts through a particular view (located on that

workstation or elsewhere) and uses a particular VOB (typically located on a dedicated VOB

server host). If all the components in this operation are running the same ClearCase release,

compatibility is guaranteed.
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Table 7, Table 8, and Table 9 show the compatibility paths if all hosts are not running the same

ClearCase release. (In these tables, “client” means “ClearCase client software.”) In each table, a

component in a row can use a component in a column if there is a "yes" at the intersection of the

row and column. For example, the Table 7 shows that a 3.x view can use a 3.x VOB or a 4.x VOB,

but a 4.x view cannot use a 3.x VOB.

Specifically, these tables make two points:

➤ ClearCase 4.x clients can use only views and VOBs that reside on ClearCase 4.x hosts.

➤ ClearCase 3.x clients can use views and VOBs that reside on 3.x or 4.x hosts.

A ClearCase 4.2 client on UNIX can access a VOB on Windows NT using a snapshot view.

However, the snapshot view storage directory and the VOB storage directory must be on servers

running ClearCase 4.1 or later.

Table 7 Compatibility: Views with VOBs

3.x VOB 4.x VOB

3.x view yes yes

4.x view no yes

Table 8 Compatibility: Clients with VOBs

3.x VOB 4.x VOB

3.x client yes yes

4.x client no yes

Table 9 Compatibility: Clients with Views

3.x View 4.x View

3.x client yes yes

4.x client no yes
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Release Information for Older Releases

If you are not upgrading from the most recent previous version of ClearCase, read the release

notes for the intervening versions. These versions are located in the password-protected

ClearCase Customer area of the Rational Software Web page; go to clearcase.rational.com and

click Documentation.

NOTE: To enter the customer area, you must provide a user name and password, which is based

on your ClearCase license ID and host ID. If you do not have this information, click Cancel in the

Username/Password dialog box for instructions on how to get a user name and password. The

release notes are available only to users of ClearCase Product Family products.

Upgrading to Client Installation Can Disable Existing Views or VOBs

Client installations of Release 4.2 on Windows NT can be one of two types: one that supports

local views and VOBs, or one that does not. If a Windows NT computer contains view storage or

VOB storage directories, upgrading to the second type of client installation disables any view or

VOB whose storage directory is located on that computer. This behavior applies to all dynamic

views and snapshot views created with the defaults suggested by the View Creation Wizard or

cleartool mkview.

This situation occurs because upgrading to that kind of client installation removes the software

necessary to run view- or VOB-server processes. (The view-server and VOB-server processes

typically run on the computer on which the storage directory is located.)

Workaround for Computers with View Storage Directories

There are two options for upgrading Windows NT computers that contain view storage

directories:

➤ Configure the computer either as a ClearCase client supporting local views and VOBs, or as

a ClearCase server (which by definition supports local views and VOBs).

➤ Remove the views on this computer before upgrading to the client installation.

NOTE: Before removing the views, check in or cancel the checkout of all checked-out files and

move any view-private files that you want to keep to a directory somewhere outside the

view.
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Workaround for Computers with VOB-Storage Directories

There are two options for upgrading Windows NT computers that contain VOB-storage

directories:

➤ Configure the computer either as a ClearCase client that supports local views and VOBs or

as a ClearCase server, which by definition supports local views and VOBs.

➤ Move the VOBs on this computer to another ClearCase computer before upgrading to the

client installation.

NOTE: Moving a VOB can be a complicated process. Consider configuring the computer to

support local views and VOBs instead. For details about moving VOBs, see Administering
ClearCase.

Accessing Views and VOBs Disabled by an Incorrect Installation

Users who upgrade to a client installation and accidentally disable their views and VOBs can

reinstall ClearCase, this time choosing to configure the computer either as a client supporting

local views and VOBs or as a ClearCase server.

Upgrading Storage Locations

Prior to Release 4.1, view and VOB storage locations were supported only on Windows servers.

Release 4.1 added enhanced support for creating and managing storage locations. To enable

Release 4.2 clients to use storage locations set up in releases 3.2.1 and 4.0, you must upgrade

those storage locations.

Upgrading a Storage Location from the Graphical User Interface

To upgrade a storage location:

1. On a Release 4.2 Windows server, start the ClearCase Server Storage Configuration Wizard

from ccase-home-dir\etc\SvrStor.exe.

2. Select Yes, start storage configuration now. Click OK.

3. On the second page of the wizard, select the UNC path of the storage location that you want

to upgrade, and click Add.

The Storage Location Attributes dialog box appears.
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4. Enter a name for the storage location. Click OK.

5. Click Next and then Finish.

Upgrading a Storage Location from the Command-Line Interface

To upgrade a storage location:

1. On a Release 4.2 Windows client, issue the cleartool mkstgloc command. Specify the path of

the existing storage location and the name of the storage location. For example:

cleartool mkstgloc –view upgraded_views \\saturn\bert\stgloc\vws

ClearCase recognizes that you are upgrading an existing storage location and prompts:

Advertise “old” Server Storage Location “\\saturn\bert\stgloc\vws”? [no] y

2. Enter y to have ClearCase register (advertise) the storage location with the new name.

Upgrading Storage Location for Interoperation Snapshot View Scenario

When you create a snapshot view, you can locate the view’s storage directory either under the

snapshot view’s root directory or in a storage location. If you create a snapshot view on a

ClearCase 4.2 client on UNIX, you can place the view’s storage directory in an existing storage

location on a Windows server if you take the following steps:

1. Upgrade the Windows server to ClearCase 4.2.

2. Upgrade the existing (pre-4.1) storage location from an interface as described in Upgrading a
Storage Location from the Graphical User Interface or Upgrading a Storage Location from the
Command-Line Interface.

1.7 VOB Schema Version 54 and Microsoft Active Directory

Rational recommends that you reformat your VOBs to use schema version 54 as soon as possible,

especially if you are considering conversion or migration to Microsoft Active Directory. Schema

version 54 provides improved support for multiple domains, domain migration, and Active

Directory. Schema version 54 may be required when using ClearCase in a certain Active

Directory environments.
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1.8 Upgrading from ClearCase LT

Rational ClearCase LT can be easily upgraded to full-featured Rational ClearCase. ClearCase

includes a tool that helps automate the upgrade process, though a few manual steps may be

required to upgrade certain configurations. The upgrade preserves all of your ClearCase VOB

data.

The Upgrading ClearCase LT to ClearCase chapter in the ClearCase Product Family Installation Notes
explains the upgrade process in detail and describes two common upgrade scenarios.

1.9 MultiSite Compatibility with ClearCase

MultiSite is layered on ClearCase. To use MultiSite on a host running ClearCase 4.2, you must be

running Release 4.2 of MultiSite.

MultiSite Release 4.2

ClearCase MultiSite Release 4.2 is fully compatible with ClearCase Release 4.2 client and server

hosts:

➤ A MultiSite 4.2 replicated VOB can reside on any ClearCase Release 4.2 server host.

➤ Any ClearCase Release 4.2 client program can access and modify any replicated VOB

residing on a ClearCase Release 4.x server host. Other client-VOB access is the same as that

documented in Feature Compatibility Issues Across Releases on page 9.

➤ Installing MultiSite 4.2 does not require you to reformat VOBs or views.

Compatibility Issues Across MultiSite Releases

The following sections describe compatibility restrictions and issues when different sites are

running different MultiSite releases.
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Replica Creation

There are compatibility restrictions on creating replicas. You cannot create a replica on a Release

3.2.1 host from a replica-creation packet created on a Release 4.x host. If you want to create a new

VOB family with replicas on Release 3.2.1 and Release 4.x hosts, the VOB from which you export

the replica-creation packet must be located on a host running Release 3.2.1.

Replica Synchronization

Existing replicas hosted on systems running ClearCase 4.x can synchronize with existing replicas

on systems running ClearCase 3.2.1. See the information on feature levels in ClearCase MultiSite
Manual.

Upgrading to New Schema Format

If you decide to update one or more replicas in a VOB family to use the latest VOB database

schema format (schema 54), you do not have to update all other replicas in the VOB family at the

same time. However, you must update all other replicas in the family before the reformatted

replicas exceed the database limit of the previous schema (53). If you do not, synchronization

imports will fail at any replica that has not been updated.

Enabling VOB Replicas for Interoperation

In Releases 4.1 and 4.2, VOBs are enabled for interoperation (MS-DOS text mode) by default.

When you create a new VOB on a host running Release 4.1 or 4.2, the VOB is enabled for

interoperation. However, when you create a new replica, the new replica gets the same

text-mode property as the original VOB.

For example, you run mkreplica –export on a Release 4.0 host to replicate a VOB that is not

enabled for interoperation, and then run mkreplica –import on a Release 4.2 host. The new VOB

replica is not enabled for interoperation.

NOTE: When you replicate a VOB, the new replica has the same text-mode property as the

original VOB, but changes to the text mode are not included in synchronization update packets.

1.10 ClearQuest Compatibility with ClearCase

ClearCase 4.2 can be integrated with Rational ClearQuest software in two different ways:
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➤ If you are using ClearCase with the Unified Change Management (UCM) process, a

UCM-ClearQuest integration is built in to this release; you can use it with ClearQuest

Version 2001A.04.00 or later.

➤ If you are using base ClearCase (that is, not using the UCM process), you can integrate with

ClearQuest 1.1 or later using the ClearCase-ClearQuest integration 1.0.

ClearQuest-enabled UCM with ClearQuest MultiSite is currently in beta test. If you would like

to participate in this beta program, please contact your Rational account representative.

1.11 Using ClearCase and Windows NT Server Domains

ClearCase is a distributed client/server application; many operations initiated on client hosts are

completed by server processes elsewhere in the network. Therefore, all ClearCase hosts running

Windows NT must belong to a Windows NT Server Domain, except as noted in Administering
ClearCase. On all Windows 98 hosts, the Client for Microsoft Networks component in Network

properties must be configured to log on to a Windows NT Server Domain.

To use ClearCase from either Windows NT or Windows 98, you must log on to a domain account

(not a local, per-system user account). For more information about Windows NT Server

Domains, see Administering ClearCase.

1.12 Known Issues Related to Installation

This section describes known installation issues.

Installing Internet Explorer 4.0.1 SP1

For some features of Release 4.2 to perform properly, Microsoft Internet Explorer 4.0.1 (Service

Pack 1) or a later version of Internet Explorer must be installed on your system. This is required

for the ClearCase Administrative Console (implemented as a set of snap-ins to the Microsoft

Management Console), for use of the ClearCase Automation Library (CAL), and for use of the

enhanced Diff Merge Tool with HTML files.
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Note that it is not necessary to run Internet Explorer as a browser on the system; it simply needs

to be installed.

Installing Java VM with Internet Explorer

Recent versions of Microsoft Internet Explorer no longer install the Java virtual machine (VM) by

default. The VM is required for using the ClearCase Web interface. The only way to install it is to

do a custom install of IE and select the Microsoft virtual machine component.

Setting Up the VisualAge for Java Integration

The ClearCase integration with Visual Age for Java enables you to use ClearCase source control

functions, such as checking out, modifying, and checking in your files, without leaving the

Visual Age for Java IDE or starting another application.

Before you can configure the VisualAge for Java for ClearCase integration, you must install both

VisualAge for Java and ClearCase, in any order, and then run the VisualAge for Java Integration

Configuration Wizard. This section describes all three procedures.

Installing VisualAge for Java

1. Run the installation program for IBM VisualAge for Java Version 3.5, Enterprise Edition.

Follow the installation instructions and prompts.

2. During the installation, select the Custom option. In the list of components to install, select

the External Version Control option.

3. Download and install the latest patch from www.ibm.com for the VisualAge for Java Version

3.5, Enterprise Edition.

Installing ClearCase

If ClearCase is already installed and running on your system, skip this procedure. If ClearCase

is not installed, run the ClearCase installation program as you normally would, with the addition

of the following steps.

1. Step through the installation to the Standard or Custom Client Configuration window.

Click I will create my own custom client configuration, and click Next and continue with

the installation.
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2. In the Site Defaults window, click No, I will customize this ClearCase installation. Click

Next and continue with the installation.

3. In the Start Menu Entries window, locate the list of ClearCase Administration Start Menu

entries. Click VisualAge for Java Integration Configuration. Click Next and finish the

ClearCase installation.

Running the Configuration Wizard

After both VisualAge for Java and ClearCase are installed, you must run the VisualAge for Java

Integration Configuration Wizard. Select one of the methods listed here.

➤ If you installed ClearCase using the procedure titled Installing ClearCase in this section:

In your Windows taskbar, click Start>Programs>Rational ClearCase
Administration>Integrations >VisualAge for Java Integration Configuration.

➤ If ClearCase was previously installed or if the VisualAge for Java Integration
Configuration shortcut menu does not appear in the Integrations menu:

a. In your Windows Taskbar, click Start>Run.

b. In the Run window, enter the path to the file, vaj_config.exe, in the bin folder of your

ClearCase installation. For example, a typical path is

C:\Program Files\Rational\Clearcase\bin\vaj_config.exe.

c. Click OK.

Set CLEARCASE_PRIMARY_GROUP on Windows Systems

ClearCase access controls consider domain group membership information when determining a

user’s rights to access ClearCase data. Because of a bug in Windows NT, a user who logs on to a

domain account may not be assigned the primary group specified by the Windows NT domain

account management tools.

To work around this bug, we recommend that you set the user environment variable

CLEARCASE_PRIMARY_GROUP to refer to the correct primary group. The value of this variable

must be the name of an existing domain group that meets all of the following requirements:

➤ It includes the user as a member.

➤ It appears on the users group list.
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This environment variable must be set on every ClearCase host. On Windows NT systems, you

set the value of CLEARCASE_PRIMARY_GROUP using the System program in Control Panel. On

Windows 98 or Windows Me systems, you must set value of CLEARCASE_PRIMARY_GROUP in the

autoexec.bat file on each system that run ClearCase.

For more information on CLEARCASE_PRIMARY_GROUP and ClearCase access controls, see

Administering ClearCase.

Slashes in Installation Directory Not Supported

The ClearCase Installation Directory box in the ClearCase Installation Wizard does not support

slashes (/).

Reinstall When ClearCase/MultiSite or ClearQuest/Shipping Server Are
Uninstalled

If you are using ClearCase/MultiSite and the Rational Shipping Server on the same computer

and uninstall one of those products, the other is partially uninstalled and stops working.

Uninstall both and reinstall the product that is needed.

ClearCase Doctor Issues Error During Install over Shipping Server

When installing ClearCase on a computer that has the Rational Shipping Server installed,

ClearCase Doctor reports an error:

Your ClearCase Server Process is set to log on as a user local to this machine.
It should be configured to log on to a Windows NT domain.

You can ignore this error message because the ClearCase installation creates the appropriate

account.

Deinstalling ClearCase May Remove Web Interface Views

By default, views for Web interface users are created under the host data directory for ClearCase

(ccase-home-dir\var). If ClearCase is deinstalled, the view directories are deleted, but the views
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remain registered. To avoid leaving entries for nonexistent views in the ClearCase registry, do

one of the following:

➤ Remove any views created by Web interface users before removing ClearCase from a Web

server used to provide access to the ClearCase Web interface.

➤ Use the –view_storage option in the ccweb.conf file to designate some other location for

Web interface views.

The var directory is not removed by the deinstall process. You must explicitly choose to remove

the directory.

Installation of UCM Integration with Rational ClearQuest

To use the UCM integration with ClearQuest, take into account the following issues with the

compatibility and version support of the following elements:

➤ ClearCase version (client and server)

➤ ClearQuest version

➤ UCM schema package

➤ ClearQuest metaschema feature level

Consider the following points:

➤ The feature level of the metaschema for ClearQuest 2001.03.00 database is 3. The feature

level for ClearQuest 2001A.04.00 database is 5.

➤ A ClearCase 4.2 client requires a ClearQuest 2001A.04.00 client, because the integration of

UCM with ClearQuest uses new ClearQuest API calls.

Table 10 shows the compatibility of different releases of ClearCase and ClearQuest, the UCM

package revision number, and the ClearQuest database feature level.

Table 10 Integration of UCM with Rational ClearQuest

ClearCase
release

UCM package
revision number

ClearQuest database
feature level

UCM/CQ integration
supported?

4.1 2.0 3 Yes

4.1 2.0 5 No
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To upgrade to Release 4.2 from 4.1 and continue to use your integration of UCM with

ClearQuest, you must perform Step #1 and Step #2. Step #3 and Step #4 are optional.

1. Install ClearQuest.

2. Install the ClearCase client (or both ClearQuest and ClearCase simultaneously).

3. Upgrade your UCM-enabled ClearQuest schema with the new version of the

UnifiedChangeManagement package.

4. Upgrade your ClearQuest user database to the new version of the schema.

Job Scheduling Mechanism Changes Affect Installation

In Release 4.0, ClearCase provided a job scheduling service, which sends e-mail notifications and

supports remote administration with access control. The scheduler relies on two new data

repositories:

➤ A database of tasks (executable programs or scripts) available for scheduling

➤ A database of jobs, or scheduled tasks

If you are installing Release 4.2 directly from 3.x, read the rest of this section.

The scheduling service changes the scheduling mechanism used in releases prior to Release 4.0.

4.1 3.0 3 No

4.1 3.0 5 No

4.2 2.0 3 Yes

4.2 2.0 5 Yes

4.2 3.0 3 Yes

4.2 3.0 5 Yes

Table 10 Integration of UCM with Rational ClearQuest

ClearCase
release

UCM package
revision number

ClearQuest database
feature level

UCM/CQ integration
supported?
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➤ The use of disprun and at to run periodic ClearCase jobs is obsolete. To schedule and

manage jobs, use the cleartool schedule command or the scheduling interface in the

ClearCase Administration Console.

➤ The scheduling directory used in previous releases, ccase-home-dir\config\cron, is obsolete.

As of Release 4.0, editable tasks reside in ccase-home-dir\var\scheduler\tasks, and

standard (read-only) ClearCase tasks reside in ccase-home-dir\config\scheduler\tasks.

NOTE: The at-based mechanism for MultiSite jobs still works, but we strongly recommend that

you use the new scheduling mechanism. Support for the old mechanism will be dropped in the

next major release of ClearCase. See Job Scheduling Mechanism Changes for MultiSite on page 23.

A task must be defined in the task database before you can schedule the task. The task database

is a text file, ccase-home-dir\var\scheduler\tasks\task_registry. A member of the ClearCase
group can add task definitions to the task database by editing this file using a text editor.

Tasks that you define can reside anywhere in the file system, but the recommended location is

ccase-home-dir\var\scheduler\tasks. This directory contains a task, ccase_local_day.bat, that is

intended for user-defined operations to be run daily. The directory contains another task,

ccase_local_wk.bat, which is intended for user-defined tasks to be run weekly. A member of the

ClearCase group can customize these two tasks using a text editor or can create entirely new tasks.

The database of jobs is the file ccase-home-dir\var\scheduler\db. This is a binary file that you can

read and edit only by using the schedule command or the scheduling user interface.

When you upgrade from 3.x, ClearCase installation takes the following actions:

➤ Moves any existing customized ccase_local_day.bat and ccase_local_wk.bat scripts from

the directory ccase-home-dir\config\cron to the directory

ccase-home-dir\var\scheduler\tasks.

➤ Deletes all ClearCase-installed standard scripts from the directory

ccase-home-dir\config\cron, regardless of any changes to those scripts since ClearCase

installed them.

➤ Deletes the directory ccase-home-dir\config\cron if it is now empty; otherwise, installs a

README file in that directory warning that the directory will be deleted in a future release.

If you have added any local scripts to the directory ccase-home-dir\config\cron, you must

move them to another directory. The recommended location is

ccase-home-dir\var\scheduler\tasks.
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➤ Removes all standard ClearCase jobs from the at list of scheduled jobs. Any local

customization of execution times of these jobs are lost; you must reestablish your

customization using the new ClearCase scheduler.

➤ Installs standard ClearCase tasks in the directory ccase-home-dir\config\scheduler\tasks.

ClearCase also takes the following actions to initialize the task and job databases:

➤ Installs a template for an initial task database, which contains definitions for standard

ClearCase tasks, as the file

ccase-home-dir\config\scheduler\tasks\templates\task_registry. The albd_server uses

this template to create the first version of the actual task database,

ccase-home-dir\var\scheduler\tasks\task_registry.

➤ Installs templates for two customized tasks, ccase_local_day.bat and ccase_local_wk.bat, in

the directory ccase-home-dir\config\scheduler\tasks\templates. The albd_server uses

these templates to create initial versions of these tasks in the directory

ccase-home-dir\var\scheduler\tasks if they do not already exist in that directory.

➤ Installs an initial set of job definitions as the text file

ccase-home-dir\config\scheduler\initial_schedule. These job definitions rely on task

definitions in the task registry template. The albd_server uses these job definitions to create

the first version of the scheduler job database, ccase-home-dir\var\scheduler\db.

NOTE: Do not edit or delete any files in the directory tree whose root is

ccase-home-dir\config\scheduler. For more information, see the schedule reference page.

Job Scheduling Mechanism Changes for MultiSite

MultiSite installation for this release takes the following actions:

➤ Installs standard MultiSite tasks (the synchronization scripts sync_export_list.bat and

sync_receive.bat) in the directory ccase-home-dir\config\scheduler\tasks.

➤ Installs a sample set of MultiSite job definitions as the text file

ccase-home-dir\config\scheduler\multisite.schedule. These job definitions rely on task

definitions in the task registry (ccase-home-dir\var\scheduler\tasks\task_registry).

The MultiSite installation does not delete any MultiSite jobs on the at list of scheduled jobs.

If you are upgrading to MultiSite Release 4.2 and you want your existing export and import jobs

to continue to work, do one of the following:
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➤ Do not deinstall the previous release.

➤ Copy the existing scripts to a directory outside the ClearCase installation area. After

installing Release 4.2, re-create the script directory and move the scripts there.

For information on converting to the new scripts and scheduling mechanism, see Converting to
New MultiSite Scripts and New ClearCase Scheduler on page 84.

NOTE: Do not edit or delete any files in the directory tree whose root is

ccase-home-dir\config\scheduler.

For more information, see the schedule reference page.

ClearCase Client Computers Need Consistent Character Encoding

All ClearCase clients computers that access a common set of VOBs and views must use a single

common character encoding system. If all computers are not configured this way, ClearCase

operations may fail or produce confusing or unreadable output.

For example, the Japanese SJIS and Japanese EUC encoding systems are available. They both

represent Japanese characters but are incompatible. For this reason, you cannot mix SJIS and

EUC in ClearCase clients.

Intermittent Problem with ALBD Server During Installation

Occasionally, when installing Release 4.2, the installation may display the following error

message:

Error 1069: ClearCase ALBD could not log in due to wrong password.

(Note that you may have to check the Event Viewer in order to see this error.)

If you see this error message, follow the steps below to correct the problem:

1. Start Control Panel>Services. (On Windows 2000, start Control Panel>Administrative
Tools>Services).

2. Select Atria Location Broker.
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3. Click Startup. (On Windows 2000, click Action>Start).

4. Type a new password in the Password box, and confirm it in the Confirm Password box.

5. Click OK.

6. Click Start.

Attempt to Replace Read-Only sitedefs.dat File Silently Fails

Site preparation may fail to replace an existing sitedefs.dat in a release area, if either the file or

whole directory is set to read-only by the network (and not by the file attributes). If this happens,

no error is reported. Instead, the install reports that the siteprep has completed successfully, in

spite of the fact that the sitedefs.dat file is not updated.

DDTS Integration Uses Wrong Environment Variable

The DDTS trigger scripts use the CLEARCASE_PNAME environment variable, but this EV is not set.

Instead, the CLEARCASE_PN EV is set to the correct value.

Workaround: Set CLEARCASE_PNAME to CLEARCASE_PN at the beginning of each trigger that uses

the EV.

Notice for expat XML parser

This product incorporates the expat XML parser 1.0 under the Mozilla 1.1 license available at

www.mozilla.org/MPL/MPL-1.1.txt. The source code version of the expat XML parser is

available at www.jclark.com/xml/expat.html.

Changes to Attache Installation

In this release, Attache shortcuts are installed in the same Start menu folder as ClearCase

shortcuts if ClearCase is installed. If ClearCase is not installed, Attache shortcuts are installed in

the Rational ClearCase folder. The default installation location is a sibling directory (named
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Attache) of the ClearCase installation directory if ClearCase is installed. If ClearCase is not

installed, Attache is installed in Program Files\Rational\Attache.
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22 What’s New in ClearCase

This chapter summarizes significant new and changed features in Release 4.2 of Rational

ClearCase.

For Release 4.2, the only new documentation provided (aside from this document and the

ClearCase Product Family Installation Notes) is the ClearCase Product Family Documentation
Supplement, which describes features new in Release 4.2.

2.1 Summary of Changes in This Release

ClearCase Release 4.2 introduces the following significant changes:

➤ Changes to UCM Integration with ClearQuest
➤ New UCM Features
➤ Multiple Site Default Files
➤ File Importer Utility
➤ Supporting Users Who Are Members of More Than 32 Groups
➤ Automatic Checkout of DO Versions During Builds
➤ Additional Option for Selecting Snapshot View Storage Directory
➤ Integration with Sun Forte for Java
➤ Integration with Visual Age for Java
➤ Changes to ClearCase Commands
➤ Documentation Changes
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2.2 Changes to UCM Integration with ClearQuest

This section describes changes to the ClearQuest/UCM integration.

Enabling ClearQuest to Work with UCM

Release 4.2 adds ClearCase support for the new release of ClearQuest. To enable a ClearQuest

schema to work with UCM, you must apply a new package, AmStateTypes, to the schema. For

details, see the ClearCase Product Family Documentation Supplement.

Changing to Default for “Check Assignment Before Work On” Policy

In Release 4.2, the default setting for the Check Assignment Before Work On policy has been

changed to not set. To enable this policy:

1. Display the project’s property sheet.

2. Click the ClearQuest tab

3. Click the check box next to the Check Assignment Before Work On policy.

4. Click OK.

2.3 New UCM Features

Following are features new in UCM:

➤ Obsolete Objects in UCM Listings

➤ UCM Triggers

➤ Privileged Identities for PVOB Write Operations

➤ Component Tree Browser Enhancements

➤ Changes to ClearQuest-Enabled UCM Using MultiSite
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Obsolete Objects in UCM Listings

By default, UCM listing commands do not list obsolete objects. A new option, –obsolete,

includes obsolete objects in the listing. See the reference pages for lsactivity, lsbl, lscomp,

lsproject, and lsstream in ClearCase Product Family Documentation Supplement.

UCM Triggers

ClearCase Release 4.2 adds support for UCM triggers on the following UCM operations:

➤ deliver
➤ mkactivity
➤ mkbl
➤ mkstream
➤ rebase
➤ setactivity

For information on how to use the triggers on UCM operations in Release 4.2, see the chapter,

Using Triggers to Enforce Development Policies in the ClearCase Product Family Documentation
Supplement. See also the reference pages for mktrtype, mktrigger, and rmtrigger in the ClearCase
Product Family Documentation Supplement.

Properties information for triggers used with UCM objects is now shown on the Firing
Conditions tab of the property sheet for a trigger.

If a client is running Release 4.1 or earlier, UCM triggers will not fire.

Privileged Identities for PVOB Write Operations

Commands that write to the UCM project VOB (PVOB) now require a privileged identity. The

following commands write to the PVOB:

➤ chactivity
➤ chbl
➤ chproject
➤ chstream
➤ clearjoinproj
➤ deliver
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➤ mkactivity
➤ mkbl
➤ mkcomp
➤ mkproject
➤ mkstream
➤ rebase
➤ rmactivity
➤ rmbl
➤ rmcomp
➤ rmproject
➤ rmstream
➤ setplevel

See the corresponding reference pages in ClearCase Product Family Documentation Supplement for

details.

Component Tree Browser Enhancements

To reduce the amount of information that the Component Tree Browser displays for UCM

streams and baselines, the Filtering Options dialog box was added. The filtering also reduces the

amount of time necessary to load the component depicted on the tree. For streams, you can

display no development streams, your own development stream only, or all development

streams in the component. For baselines, you can display only the baselines of a given promotion

level or higher, only labeled baselines, or obsolete baselines. For details, see the online help for

the Component Tree Browser.

Changes to ClearQuest-Enabled UCM Using MultiSite

Rational ClearQuest Version 2001A.04.00 lets you use ClearQuest MultiSite to replicate

ClearQuest databases. Note the following:

➤ This feature is in beta test. If you want to participate in this beta program, contact your

Rational account representative.

➤ If you plan to link a UCM project with a replicated ClearQuest user database, see the

chapter, Setting Up a ClearQuest User Database in the ClearCase Product Family Documentation
Supplement.
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2.4 Multiple Site Default Files

ClearCase now allows you to have multiple site defaults files for a release area. In some cases,

your site may require multiple site defaults files. For example, if two groups both use ClearCase

but need to work with different default settings (such as different Start menu commands or

different registry servers), you can create one site defaults file for each group.

For instructions on using the expanded ClearCase Site Preparation from the release area, click

Help in the dialog box. You can also find information in the section, Running the ClearCase Site
Preparation Wizard in the ClearCase Product Family Installation Notes.

2.5 File Importer Utility

A new utility, clearfsimport, allows you to place source files under ClearCase version control

without having to use one of the clearexport utilities. You can use it in UCM or base ClearCase.

For details, see the clearfsimport reference page in the ClearCase Product Family Documentation
Supplement.

2.6 Supporting Users Who Are Members of More Than 32 Groups

Release 4.2 supports the use of a new environment variable on Windows NT and Windows 2000

platforms. If the environment variable CLEARCASE_GROUPS exists for any user, ClearCase

considers the semicolon-separated list of groups specified as the value of this variable first when

determining (or displaying) which groups a user belongs to. For example:

CLEARCASE_GROUPS=domain\ClearCase Users;domain\group;domain\group

The list can contain domain or local groups, and need not contain the group specified in

CLEARCASE_PRIMARY_GROUP, which is already treated specially if it has been specified. If the user

is a member of additional groups not specified in CLEARCASE_GROUPS, ClearCase considers those

groups after it has considered the groups listed in CLEARCASE_GROUPS, up to a limit of 32 groups.

Any user who is a member of more than 32 groups (domain or local) should set

CLEARCASE_GROUPS to specify which groups ClearCase should consider when checking the

user’s access rights. CLEARCASE_GROUPS is not supported on Windows 98 or Windows Me.
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2.7 Automatic Checkout of DO Versions During Builds

You can use the new –c option for the clearmake command and –C for the omake command to

guarantee that any versioned derived objects (DOs) referenced in a makefile are checked out

before they are rebuilt or winked in. This option causes clearmake and omake to examine each

of the makefile’s targets to verify that the target is visible in the view at the same path and is a

checked-in, versioned DO. All such DOs are checked out before they are rebuilt or winked in.

If you define the environment variable CCASE_AUTO_DO_CI, the clearmake and omake
commands check in any checked-out versioned DOs associated with a target after that target is

rebuilt or winked in. These checkins are not audited, and the build reference time prevents

subsequent builds of the target in the same build session from seeing the results of these

checkins. If the target creates sibling DOs, target group syntax must be used in the makefile so

that all siblings are subject to this new behavior.

All checkouts are reserved. The checkouts are not audited. Checkin operations preserve the time

stamp of the DO as if checkin –ptime were used. The feature is fully compatible with checkout
or checkin triggers which fire normally when the event occurs.

For more information, see the reference pages for clearmake and omake in ClearCase Product
Family Documentation Supplement.

2.8 Additional Option for Selecting Snapshot View Storage
Directory

In Release 4.1, if you created a snapshot view that did not use a server storage location, you could

only colocate view storage under the root of your snapshot view directory. This resulted from the

withdrawal in Release 4.1 of support for the mkview –vws option. Release 4.2 restores this

functionality, which enables you to specify a non-colocated storage directory that is not a server

storage location. See the mkview reference page in the ClearCase Product Family Documentation
Supplement.

When using the Choose Location for a Snapshot View dialog box, you can also click Advanced
Options and then click Use explicit path to specify non-colocated view storage that is not at a

server storage location.
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2.9 Integration with Sun Forte for Java

This release integrates SCC-level ClearCase functionality with Sun Microsystems’s Forte for Java

on these platforms:

➤ Windows 98

➤ Windows Me

➤ Windows NT

➤ Windows 2000

Users of the Java IDE initiate ClearCase actions using the file-system shortcut menus and a set of

command icons on the Forte for Java main window toolbar. The following functions are

available:

➤ Check In
➤ Check Out
➤ Add to Source Control
➤ Undo Checkout
➤ Properties
➤ Compare to Predecessor
➤ Source Control History
➤ Version Tree Browser
➤ ClearCase Explorer

ClearCase integrated help appears as a book in the Forte for Java online help, which you can

access from the IDE Help menu. Context-sensitive help, invoked by pressing F1, is also available

for the ClearCase commands.

2.10 Integration with Visual Age for Java

This release enhances the integration of SCC-level ClearCase functionality with the IBM

VisualAge for Java Release 3.5 on the following platforms:

➤ Windows 98

➤ Windows NT

➤ Windows 2000
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You can develop projects in the VisualAge for Java IDE while performing ClearCase version

management using the file-system shortcut menus and a set of command icons on the VisualAge

for Java main window toolbar.

The integration enhancements provide access to more ClearCase functionality from within

VisualAge for Java. Specifically:

➤ Unified Change Management (UCM) Join Project
➤ Merge Manager
➤ Create View
➤ Update View
➤ Find Checkouts

In previous releases, the following ClearCase functionality was made available:

➤ Unified Change Management (UCM) Deliver and Rebase operations

➤ Version Tree Browser
➤ Help on using the integration

For more information on VisualAge for Java including new updates and limitations, read IBM’s

release notes on VisualAge for Java.

Setting Project Properties When a Project is Added to Version Control

After a project is added to External Version Control, users must set the project properties to tell

VisualAge for Java, on a refresh project, to refresh the project from the external version control

repository. To set the project properties in VisualAge for Java:

1. On the shortcut menu for the project, click Tools>External Version Control>Properties.

2. Click the SCCI tab.

3. Click Refresh project from working directory.

Handling of Resource Files in VisualAge for Java

There is a defect associated with adding a resource to a project that is under source control. The

green arrow or yellow plus sign is not updated after the resource has been added as an element

to ClearCase.
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Known Problem with Lengthy Error Messages

If you add projects with very long names—including long class names—to source control, an

error message is displayed. The error routine can not handle very long error messages that result

from adding these types of projects to source control.

Modifications to External Version Control Icons

For this integration, two VisualAge for Java version control icons were modified. The ClearCase

icon with the yellow triangle and green arrow was changed to a yellow diamond with an

exclamation point in the middle; the green arrow remains. The icon indicates that an object in

version control was modified by a save operation.

The icon with the yellow lock and green arrow was changed to a gray lock on top of the yellow

diamond with the green arrow. This icon indicates that a checked-out object in version control

was modified by a save operation.

See the topic Version control icons, in the Help for the ClearCase integration with VisualAge for

Java.

2.11 Changes to ClearCase Commands

This section lists new commands and describes changes to existing commands.

New Commands

Table 11 lists new commands.

Table 11 New Commands in Release 4.2

Command Description

clearfsimport An importer that can be run in UCM views.
2 - What’s New in ClearCase 35



New Options and Arguments

Table 12 lists new options and arguments.

Table 12 New Options in ClearCase 4.2

Command
New
option/argument

Use

clearmake –c Guarantees that versioned derived objects

(DOs) referenced in a makefile are checked

out before they are rebuilt or winked in.

diffbl –predecessor
[ –activities ]

[ –versions ]

baseline-selector

Displays differences between two baselines

or streams nongraphically.

–graphical
baseline-selector1
baseline-selector2

Displays differences between two baselines

graphically.

–graphical
–predecessor
baseline-selector

Displays differences between the specified

baseline and its predecessor baseline

graphically.

lsactivity
lsbl
lscomp
lsfolder
lsproject
lsstream

–obsolete Specifies that obsolete objects are to be

included in the listing.

mktrigger ucm-object-selector Attaches a trigger to the specified UCM

object.
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Obsolete Commands

No commands are obsolete in this release.

2.12 Documentation Changes

For Release 4.2, the ClearCase and MultiSite Release Notes (this document) and the ClearCase
Product Family Installation Notes are the only manuals that were updated. All new features in 4.2

are documented in the ClearCase Product Family Documentation Supplement, which is installed as

ccase-home-dir\bin\cpf_supplement.pdf.

mktrtype –ucmobject Creates a trigger type that can be attached to

individual UCM objects.

–ucmobject –all Creates a trigger type that can be attached to

all project VOB objects.

–component
component-selector[,...]

Specifies components for the restriction list.

–project
project-selector[,...]

Specifies projects for the restriction list.

–stream
stream-selector[,...]

Specifies streams for the restriction list.

mkview –vws
view-storage-pname

Specifies the location for the view storage

directory.

omake –C Guarantees that versioned derived objects

(DOs) referenced in a makefile are checked

out before they are rebuilt or winked in.

rmtrigger ucm-object-selector Removes a trigger from the specified UCM

object.

Table 12 New Options in ClearCase 4.2

Command
New
option/argument

Use
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33 What’s New in MultiSite

This chapter summarizes new and changed features in this release of Rational ClearCase

MultiSite.

For more information about the commands described in this chapter, see the reference pages in

the ClearCase MultiSite Manual. For information about the feature level requirements for using

these features, see Guidelines for Using Feature Levels on page 72.

3.1 lsepoch and chepoch Detect Missing Oplog Entries

The lsepoch –actual and chepoch –actual commands now detect whether the remote replica or

the current replica is missing oplog entries. If oplog entries are missing, the command prints one

of the following messages:

Your replica (" replica-name") has fewer oplog entries for itself than
" replica-selector" has for your replica.
To avoid permanent data loss, your VOB administrator must initiate the
documented replica restoration procedure.

The replica " replica-name" has more oplog entries for " replica-selector" than
" replica-selector" has for itself.
To avoid permanent data loss, its administrator must initiate the documented
replica restoration procedure.
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3.2 New Configuration File for Synchronization Scripts

You can modify the behavior of the sync_export_list and sync_receive scripts by creating a file

named MSimport_export.conf and setting values in it. On UNIX, create the file in the directory

/var/adm/atria/config. On Windows, create the file in the directory ccase-home-dir\var\config.

The file can include the following export setting:

disable_export_locking = 1

Disables use of the export lockfile, allowing multiple exports from a single replica to run

simultaneously. Setting the value to 0 (default) enables use of the lockfile.

The file can include the following import settings:

disable_import_locking = 1

Disables use of the import lockfile, allowing multiple imports to a single replica to run

simultaneously. Setting the value to 0 (default) enables use of the lockfile.

NOTE: Disabling import locking may cause import failures due to collisions. We

recommend that you leave locking enabled unless there is frequent lockfile contention.

proactive_receipt_handler = 1

Causes an active receipt handler to look for other packets that can be imported and

attempt to import them. By default, a receipt handler imports only the packet for which

it was invoked. Under high load conditions or when packet have been split because of

maximum size restrictions, packets may arrive before a preceding packet has been

completely processed. Enabling proactive mode causes the receipt handler to import

packets that may otherwise be stranded because delivery was premature or out of order.

3.3 Change to Packet Names Generated by Synchronization Script

When you use the –compress option with the sync_export_list script, the names of the shipping

order and update packet now contain up to 40 characters of both the exporting and importing

replica names. This naming scheme helps to ensure unique packet names.

Also, the time stamp now appears before the replica names, so the packets are listed in time order

when you list the files in a shipping bay.
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44 Restrictions and Guidelines for
ClearCase

This chapter provides guidelines for and restrictions on using Release 4.2 of Rational ClearCase.

For information about previous releases, see Release Information for Older Releases in Chapter 1,

READ ME FIRST.

4.1 Guidelines for Using UCM

The following section describes restrictions on using Unified Change Management (UCM) at

ClearCase Release 4.2.

When Setting Up a Project, Make Components Read-Only Initially

You cannot change an integration stream’s configuration to use an earlier baseline of any

components that are marked as modifiable by the stream’s project.

This may be a problem when creating a new project if the set of foundation baselines is not

known in advance. After a modifiable baseline has been added to a project, it is not possible to

roll back to an earlier baseline later on if building or testing indicates this is necessary.

To work around this limitation, initially specify your components to be nonmodifiable when

creating a new project. After verifying that the project builds and tests correctly, update the

project policies to allow modifications to any/all components.
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Check In to Non-UCM VOB from UCM View if ClearQuest Enabled

If, in a UCM view, you check out or check in an element from a VOB that is not a UCM

component, you should not have to select an activity, because that operation is not captured in a

change set.

However, if you are in a view that is in a ClearQuest-enabled project, both the Check Out dialog

box and the Check In dialog box force you to select an activity even though one is not really

required.

Workaround: Select the activity; it will be ignored.

Using UCM in a MultiSite Environment

When you join a project in which the integration stream is not mastered by your current replica,

you can create a development stream and view, but not an integration view. The Join Project

Wizard displays a message that you will not be able to create an integration view, but when you

click Finish the wizard attempts to create the integration view and then fails. If creation of the

development view and stream succeeded, you can ignore the error.

Notes on Using the UCM-ClearQuest Integration

The UCM process in ClearCase is enhanced for sites that have installed Rational ClearQuest by

a very tight integration between the activity management provided by UCM and the change

request management provided by ClearQuest. Use the following guidelines with the

UCM-ClearQuest integration.

Transitioning a ClearQuest-Enabled Project After Delivery

If the Do ClearQuest action after delivery policy is enabled on a UCM project, delivery of a

ClearQuest-enabled UCM activity may result in an attempt to transition the activity to a

Complete state type.

If the activity record has a field that must be filled in before it can transition to the Complete state,

the program displays an error. An example is the Defect record type in the default

UnifiedChangeManagement schema, whose Resolution field must be non-empty before it can

be resolved.
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Workaround: Modify the UCU_CQActAfterDeliver global script to include code similar to that

below, which fills in the Resolution field when the activity is delivered.

’ Defect record type requires Resolution field to be non-empty
’ If record type is "Defect" ...
If (entity.GetEntityDefName = "Defect") Then

’ If Resolution field is empty...
If (entity.GetFieldValue("Resolution").GetValue = "") Then

’ Fill in required field
Call entity.SetFieldValue ("Resolution", "Fixed")

End If
End If

See the ClearQuest API documentation for information on editing entities.

Schema Requires Submitted State

If you are applying the UCM package to a custom ClearQuest schema (as opposed to using the

out-of-the-box Unified Change Management schema), be aware that this package depends on the

existence of a state whose name is Submitted. If your custom schema does not include a

Submitted state, you can apply the package to your schema by using one of the following

methods:

➤ Before applying the package, temporarily rename the state that is the target of the Submit

action to Submitted. After applying the UCM package, you may rename it to its original

name.

➤ Create a dummy state called Submitted, and assign its state type to Complete. If you do

this, you must also create a dummy action whose target is the Submitted state. After

applying the UCM package, you may delete the dummy state and action.

ClearQuest Script Error Text Not Reported

Using the UCM-ClearQuest integration, you can customize the Check Before Deliver
ClearQuest Visual Basic policy script. However, if the script as customized contains an error that

causes the Visual Basic interpreter to display an error exception, the Deliver dialog box reports

this error like this:

An error occurred during the deliver.
Unexpected error in deliver.

It does not report the actual error exception text, which would enable the user to diagnose the

problem script.
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Workaround: To see the error exception text, use the cleartool deliver command.

Must Stop ClearQuest Server to See Schema Upgrade

If you are using the UCM-ClearQuest integration, and upgrade a ClearQuest user database to a

new schema revision, to see the change on a client host connected to that user database, you must

stop the ClearQuest server and do the following:

➤ On Windows NT or 2000 clients

a. Start the Task Manager and click the Processes tab.

b. From the list, select CQINTS~2.EXE or CQINTSVR11.EXE.

c. Click End Process.

➤ On Windows 98 and Windows Me clients

a. Press CTRL+ALT+DELETE.

b. From the list, select CQINTSVR11.

c. Click End Task.

On UNIX clients, enter cqintsvr stop on the command line.

Changes to UCM CustomQuery1 Do Not Appear in Dialog Box

When using the UCM-ClearQuest integration, the list of records displayed in the list on the Add
To Source, Check Out, and Check In dialog boxes is generated by running the

UCMCustomQuery1 query, which can be customized. (Note that to see the effect of your

changes, you must use the File>Save command to save the query edits.)

However, if you copied the Public Queries UCMCustomQuery1 query into your Personal
Queries folder and edited it there, the changes are not immediately visible. To see your changes,

you must stop the integration server process.

➤ On Windows NT or 2000 clients

a. Start the Task Manager and click the Processes tab.

b. From the list, select CQINTS~2.EXE or CQINTSVR11.EXE.

c. Click End Process.
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➤ On Windows 98 and Windows Me clients

a. Press CTRL+ALT+DELETE.

b. From the list, select CQINTSVR11.

c. Click End Task.

After stopping the process on your computer, open the dialog box again. Further edits to

/PersonalQueries/UCMCustomQuery1 appear without your having to shut down the process

again.

On UNIX clients, enter cqintsvr stop on the command line.

Cannot Import UCM-Enabled Records from ClearQuest Database

In general, you cannot import UCM-enabled records from a ClearQuest database; ClearCase

cannot guarantee that UCM information that references an arbitrary ClearQuest database is

correct. However, this restriction does not prevent data recovery in the event of a data loss.

Records may be successfully imported into a ClearQuest database if all the following conditions

are true:

➤ The records have been backed up from that database.

➤ The name of the database has not changed.

➤ The ClearCase UCM information in the record is still valid.

Changing Name of ClearQuest Record Type Causes Error

In the UCM-ClearQuest integration, if you change the name of the ClearQuest record type after

activities have been linked to ClearQuest records of that record type, the integration displays an

error message when you try to set one of those activities in a view. To change the name of a record

type, do so before any activities are linked to records of that record type.

Opening Multiple Nested ClearQuest Forms May Cause Crash

The UCM-ClearQuest integration does not prevent you from opening a ClearQuest form, going

to the form’s UnifiedChangeManagement page, using the shortcut menu in the change set to

open a ClearCase dialog box, and selecting Activity Properties, which opens a second

ClearQuest form.

However, if you follow the above steps, the second ClearQuest form does not function correctly.

In particular:
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➤ The Apply, Revert, and Cancel buttons on the form have no text.

➤ If you attempt to go to the form’s UnifiedChangeManagement page, and then close the

form, you get this error:

Unable to load message ID 14090 from resources

ClearCase then crashes.

We recommend that you avoid using the above procedure to open a second ClearQuest form.

Also, we recommend that you do not attempt to use duplicate copies of the same form.

Must Re-Run ClearQuest Maintenance Tool If ClearQuest is Reinstalled

If you upgrade ClearQuest, the registry settings that keep track of the current database are

removed. You must run the Rational ClearQuest Maintenance Tool to reestablish the default

database for the computer.

Availability of Check Mastership Policy

The ClearQuest page of the UCM project Properties Browser has a check box for the policy Check
mastership before deliver. This is supported only with the UCM 3.0 package revision. If you are

using the 2.0 package revision, the check box is unavailable.

4.2 Notes on Using the Base ClearCase-ClearQuest Integration

This section provides guidelines for using base ClearCase and ClearQuest together.

Change to Integration at ClearQuest Version 2001A.04.00

If ClearQuest version 2001A.04.00 or later is installed, the ClearQuest tab of the ClearQuest

Integration Configuration GUI is disabled. With previous releases of ClearQuest, the integration

used the information that you entered on this ClearQuest tab to update a ClearQuest schema. In

ClearQuest 2001A.04.00 or later, use the Package Wizard, in the ClearQuest Designer, to update

your schema as follows:

1. In ClearQuest Designer, click Package>Package Wizard.
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2. In the Package Wizard, look for the Release 4.2 and ClearCase Upgrade 3.0 packages. If

these packages are not listed, click More Packages, and add them to the list from the Install
Packages dialog box.

3. If you are upgrading a schema that currently uses the ClearCase-ClearQuest integration

from ClearQuest version 1.1 to version 2001A.04.00 or later, select ClearCase Upgrade 4.2,

and click Next.

If you are enabling a schema to use the ClearCase-ClearQuest integration for the first time,

select Release 4.2, and click Next.

4. Select the schema for the ClearQuest user database that you want to use in the integration

with ClearCase. Click Next.

5. Select the record type of ClearQuest records to be associated with ClearCase versions. This

record type must match the record type that you specify on the ClearCase tab of the

ClearQuest Integration Configuration GUI. Click Finish.

6. Click Database>Upgrade Database to upgrade the ClearQuest user database with the new

version of the schema.

Using ClearQuest with Long Version-Extended Pathnames

The base ClearCase-ClearQuest integration creates a ClearCase tab on your ClearQuest screen.

On this tab, if you right-click CC Change Set Objects and then select View Details, the program

displays data about a VOB element. If the version-extended pathname is too long to fit in the

dialog box, it cannot be viewed in its entirety, because the form does not support horizontal

scrolling by default. You may want to modify the form using the following procedure:

1. In the ClearQuest Designer, check out the ClearQuest schema you are using.

2. Click Record Types-Stateless>cc_vob_object>Forms>cc_vob_object.

3. Select each text box and double its height.

4. Right-click a text box and click Properties.

5. Click the Extended tab.

6. Select the Horizontal Scroll Bar check box.

7. Repeat Step #4 – Step #6 with the other text box fields.
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8. Check in the schema.

9. Click Database>Upgrade Database to finish the changes.

If you wanted only the horizontal scrollbase on the name, do the following instead:

➤ In Step #3, select the Name text box and double its height.

➤ In Step #4, right-click the name text box and click Properties.

➤ Ignore Step #7, which asks you to repeat the instructions.

4.3 Restrictions on ClearCase Web Interface

The following restrictions apply to using the ClearCase Web Interface.

Restrictions on the Web Interface in a UCM Environment

If you are using the Web interface in a UCM environment, the following restrictions apply:

➤ You can only work on existing activities owned by you; you cannot create new UCM

activities using the Web interface.

➤ You cannot deliver changes to an integration view.

➤ You cannot rebase your development stream.

➤ You cannot use the Web interface to view ClearQuest-enabled projects.

Interactive Triggers Fail When Accessed Through Web Interface

The ClearCase Web interface supports noninteractive triggers. Interactive triggers, such as those

that attempt to read input or create a window, fail.

If a trigger attempts to read input using clearprompt, the ClearCase Web interface prints this

error:
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clearprompt is not supported in the Web interface

If a trigger attempts to read directly from standard input, it receives an error, because standard

input does not specify a valid file descriptor.

In addition, any trigger failure in the Web interface context displays this error message:

Interactive triggers are not supported in the Web interface.
If the trigger was interactive, it may have failed for that reason.

Trigger script writers can detect whether a trigger is running in the Web interface context by

checking for the environment variable ATRIA_WEB_GUI. It is set to 1 if you are running in the Web

interface context.

Changes to Files Not Checked Out May Be Silently Overwritten

If you use the Web interface to download (rather than check out) a file to your Web view and then

modify the file, your changes to the file are silently overwritten if you download the file again

from within the same view. The program assumes that the only changes to be saved are those

made to checked-out files.

Restrictions on Comparison of New Element Types

The Web interface does not support graphical (tree view) comparison of XML file elements; the

Web Compare tool displays a text-based comparison for elements of type xml. When comparing

HTML files, the program displays the differences in the Compare screen as text, but includes

hyperlinks to display the individual files appropriately formatted using your default browser.

In addition, because the Compare tool in the Web interface handles only text files, it does not

support comparison of Rational Rose or Microsoft Word files.

Error When Checking in Large File from Windows NT Web Client

Windows NT 4.0 sends very large amounts of information to a Web server. This behavior causes

the ClearCase Web interface to fail when attempting to check in very large files (on the order of

several megabytes). This problem appears to be fixed in Windows 2000.
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Host Name Resolution Must Be Enabled on Web Interface Clients

The Java program used in the Web interface attempts to connect to the Web server to transfer

files. Web browsers only allow Java programs to open connections to the server from which the

programs were downloaded.

To enforce this rule, the Web browser on the Web interface client must be able to resolve the Web

server’s host name to an IP address. If you use a host name in a URL that cannot be resolved by

the client host, the Java program cannot connect to the server. In this case, Web-interface

file-transfer operations such as checkout, checkin, and download fail.

If the Web server is being accessed through a firewall by means of a proxy server, the proxy

server being used must support DNS lookup outside the firewall.

ClearCase Web Interface Problem in Overriding Primary Group

When the ClearCase Web server on Windows logs in a client, it sets the primary group to the

designated primary group in the client user’s domain account. In Release 4.0, you could not

override this group setting. As a result, sites that use domain mapping to allow user accounts in

multiple domains to share VOBs could not access those VOBs through the ClearCase Web

interface.

Workaround: Specify a configuration variable in the ccweb.conf file, and add a value to the

registry that enables domain mapping.

Adding the Variable to the ccweb.conf file

To enable a single Web server to support one primary group override, add the –primary_group
variable with a groupname value to the ccweb.conf file. The allowable values for groupname are

the same as for the CLEARCASE_PRIMARY_GROUP environment variable. The ccweb.conf file must

be located in ccase-home-dir\var\config. If you need more than one primary group override,

configure additional Web servers.

Setting the Registry

Typically, when domain mapping is used to allow users from multiple domains to access the

same VOB, each user must create the DomainMappingEnabled value (set to 1) in the

HKEY_CURRENT_USER\Software\Atria\ClearCase\CurrentVersion registry key.
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To enable domain mapping for a Web server, create the DomainMappingEnabled value in the

HKEY_LOCAL_MACHINES\Software\Atria\ClearCase\CurrentVersion key on the Web server

machine. The value must be of type DWORD and set to 1.

If you log in directly to the machine instead of logging in through the Web interface, user values

for DomainMappingEnabled override the machine value.

Conflict Between Netscape and Exceed X Windows Server

If you access the ClearCase Web interface using a Netscape browser on a Windows system and

also use a version of the Exceed X Windows Server earlier than 6.0, do not let the Netscape

window lose its focus to an Exceed window. Doing so causes the Netscape window to restart any

Java applets it is currently running, which interferes with file-transfer operations, for example,

download, checkout, or checkin.

Neither Internet Explorer nor version 6.0 of the Exceed X Windows Server display this problem.

4.4 Using Internet Information Server to Serve Web Pages from a
VOB

If you intend to use Internet Information Server (IIS) to serve Web pages within a view and VOB,

you must configure IIS to log on as a Windows NT domain user that has access to that view and

VOB data, use this procedure:

1. Make sure that the views and VOBs serving the Web pages use NTFS, not FAT, for storage.

2. Start the Services Control Panel program.

3. Double-click World Wide Web Publishing Service; a Service dialog box appears.

4. Click Manual startup type, and then click OK.

5. Create a domain user who is a member of the same primary group as ClearCase users.

6. Make the user the Anonymous Login user for IIS:

a. Click Start>Programs>Microsoft Peer Web Services>Internet Service Manager.

b. Start the WWW service, if necessary.
4 - Restrictions and Guidelines for ClearCase 51



c. Double-click Service to display its property sheet.

d. Enter the user name in the format domain\user, for example, rational\webclient.

7. Start the view or views from which you want to publish and mount the VOBs you need.

8. Start the IIS service.

9. On the Directories tab, set aliases to directories in the VOB or VOBs.

IIS and ClearCase should now work together on the same computer.

NOTE: Whenever you restart your computer, always start views and mount VOBs before you start

the IIS service.

4.5 Third-Party Integration Guidelines for ClearCase Release 4.2

ClearCase contains support for Visual Studio 6.0 (including Visual InterDev) tools that use the

Microsoft Common Source Code Control Interface (SCC) integration. It also contains support for

Microsoft Word, Microsoft FrontPage, Microsoft Office 2000, and Sybase PowerBuilder. This

section contains guidelines on using ClearCase with integrated products.

Using ClearCase with Microsoft Web Tools

The ClearCase integration with Microsoft Web tools is documented in a chapter in Administering
ClearCase on configuring a Web server for use with Microsoft Web tools. Release 4.x is integrated

with FrontPage 98, FrontPage 2000, Visual InterDev, Microsoft’s Save to Web Office 2000

functionality (Word, Excel, PowerPoint), and Microsoft Internet Explorer 5 (IE5) Web Folders.

In addition, follow the guidelines below when using ClearCase is integrated with the above

programs and tools:

➤ For FrontPage 2000 in local mode with ClearCase Release 4.1, the following commands

were removed from the ClearCase menu: Home Base, ClearCase Details, View Profiles,
and Browse Types in VOB. The ClearCase Explorer command was added.

➤ If you have been running the FrontPage integration in local mode with ClearCase Release

4.0, you must upgrade to Release 4.2:
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a. Install Release 4.2 on your client.

b. Start the Web Authoring Integration Configuration Wizard. To do so, click

Start>Programs>ClearCase Administration>Integrations>Web Authoring
Integration Configuration.

c. Select Local Mode Configuration.

➤ Users/Groups that are granted Front Page Server Extensions (FPSE) Author rights must

match the identities of the Users/Groups with write access to the Web content VOB. In

particular, granting Author rights to Everyone or to the IIS Anonymous user is not

supported.

➤ The ClearCase-FrontPage Web server maintains a cache of source control information,

including checkout status, user, time, and version. This cache is not updated when source

control operations are performed using ClearCase tools such as the Version Tree Browser, or

cleartool, rather than from within a Microsoft Web program like FrontPage. For this reason,

we recommend that you perform all source control operations from within the appropriate

Microsoft Web tool. In the integration with FrontPage 2000, the ClearCase commands

Update View and Refresh Source Control Status and the iisfix.bat script can be used to

resynchronize the cached source control information.

➤ Use of FrontPage borders and themes can cause many extra source control operations to be

performed, slowing integration performance.

➤ As described in the online help for the integration, users access files using a shared

snapshot view created for the ClearCase-Web tools integration on the ClearCase Web

server; the view-tag is _fp_hostname_default-web-alias-path. If a Web uses the IIS

Challenge/Response authentication method, this view must be located on the IIS Web

server, and the VOB must either be on the same IIS Web server or on a UNIX VOB server

configured to use CCFS.

➤ If you are attempting to import an existing Web with FrontPage Server Extensions installed

into a VOB, you must remove all _vti_* directories from the Web before using

clearexport_ffile/clearimport.

Using ClearCase with Visual InterDev

The integration of Release 4.2 and Visual InterDev may cause corruption and data loss. The

problem occurs when user A checks out a file and then user B checks out the same file; user A is

permitted to check in before user B. When attempting to check in the file, user A receives an error

message and the file becomes corrupt.
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There are three ways to deal with multiple-checkout problems in Visual InterDev:

➤ Add all users who may potentially check out the same files at the same time to the

ClearCase domain group. This gives users permission to check in any files checked out by

another user.

➤ Enable simulated checkouts for all files in the Web content VOB. The actual checkout occurs

at checkin. This deferral allows multiple users to successfully check out the same file at the

same time. However, these checkouts appear only in the Visual InterDev GUI. To enable

simulated checkouts, change the value of the registry key

HKEY_LOCAL_MACHINE\Software\Atria\ClearCase\CurrentVersion\SSAPI\
Performance\SystemFiles from the default value to the string value *.

➤ Disable the multiple-checkout functionality. To do so, you must turn on a new registry key.

After this new registry key is set, Visual InterDev enforces a single checkout model. To

disable multiple checkout functionality, add the new registry key as a DWORD value:

HKEY_LOCAL_MACHINE\Software\Atria\ClearCase\CurrentVersion\SSAPI\
FailCOIfAlreadyCO

If the value is set to 1, a checkout fails if the object is already checked out.

Using ClearCase with Microsoft Visual Studio

To use the ClearCase integration with Visual Studio, users must do one of the following:

➤ Install ClearCase after installing Visual Studio.

➤ When installing Visual Studio, choose to do a custom install. Then choose to not either

install Visual Source Safe or make Visual Source Safe the Source Code Control Program.

Using ClearCase with Microsoft Visual C++

ClearCase uses the Microsoft Common Source Code Control (SCC) interface to integrate with the

Microsoft Visual C++ available through Microsoft Visual Studio. ClearCase has support for

Visual C++ versions 5.0 and 6.0. You can switch between SCC-support versions 5.0 and 6.0, but

only one version is enabled at a time.

The ClearCase SCC interface for Visual C++ 6.0 also supports Visual Basic 6.0, Visual J++ 1.1, and

Visual InterDev 6.0.
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Using ClearCase with Visual Studio components requires no special configuration on the part of

the user. For more information, see Developing Software with ClearCase in online help.

Issues with Visual C++ on Windows 2000

If you install Windows 2000 on a computer that currently runs Windows NT with the Visual

Studio integration and then reinstall ClearCase, the Visual C++ 6.0 Add-in toolbar for the

ClearCase integration contains five Version Tree buttons. All five buttons start the Version Tree

Browser. To correct the problem, remove the ClearCase toolbar and then re-add it:

1. Click Tools>Customize and click the Add-Ins tab.

2. Clear the ClearCase check box and close the dialog box.

3. Click Tools>Customize and click the Add-Ins tab.

4. Select ClearCase on the list and close the dialog box.

Using ClearCase with Microsoft Visual Basic

Disabling of the IDE During Project Debugging

Design of the Visual Basic IDE disables or unloads all add-ins while debugging a project. The

ClearCase toolbar, which is an add-in, is disabled, and no ClearCase operations can be

performed from the Visual Basic IDE while the debugger is running. ClearCase operations can

be performed while debugging using the ClearCase Explorer.

ClearCase Tools Add-In Does Not Initialize with Visual Basic 5.0

In Release 4.0, a new add-in was created for Visual Basic 6.0. The add-in does not work with

versions earlier than Visual Basic 5.0. If you use an earlier version, the following message

appears:

ClearCase tools could not be loaded
Remove it from the list of available addins?

Because the purpose of this add-in is to provide VB users quick toolbar access to advanced

ClearCase features, you can remove it from the add-ins list without affecting basic ClearCase

functions such as checkin and checkout.
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Problem Checking in Identical .frm Files in Visual Basic 6.0

By default, ClearCase does not create a new version of a file that is identical to its immediate

predecessor. When you attempt to check in an .frm file that is identical to the checked-in version,

the integration does not check it in. However, if the .frm file has an associated .frx file, the

integration checks in the .frx file as a read-only file. To avoid this problem, set the option to allow

identical checkins.

Pre-Checkin Trigger Causes Problem in Visual Basic Projects

In Visual Basic, when you attempt to add a project to ClearCase by clicking

Tools>ClearCase>Add Files to ClearCase, the operation fails if the VOB in which the Visual

Basic project resides has a trigger that requires users to enter a comment when checking in files.

The Visual Basic IDE does not supply the comment that you enter in the Add to Source Control
dialog box to the trigger.

To work around this problem, use ClearCase Explorer to add the project to source control. After

you add the project to source control, checkin and checkout operations complete successfully

from within the Visual Basic IDE.

FRX File Not Checked Out When Part of Visual Basic Group

In a Visual Basic version 6.0 project that is part of a Visual Basic Group, when you check out an

.frm file (with an .frx file), ClearCase does not check out the associated .frx file automatically. This

behavior may cause synchronization problems. When working with a Visual Basic 6.0 project

that is part of a Visual Basic Group, be sure to check out both the .frm and .frx files.

Error Message When Opening Visual Basic 6.0 Project

When you open a Visual Basic 6.0 project that is checked in, the integration displays the

following error message: Failed to update project location information in the host

application . The integration displays this message because the Visual Basic project file is not

checked out and the project location information cannot be updated. To avoid this message,

check out the project file before you open the project.

Reopening Visual Basic 6.0 Project Fails to Update Project Information

When you use Visual Basic 6.0, a problem can occur if a project’s source files reside in a dynamic

view that is mapped to drive M. After you reload it, Visual Basic cannot reopen the project from

the list of recent projects at the bottom of the File menu and displays the error message

reopening recent project fails to update project information in recent project .
56 ClearCase and MultiSite Release Notes



To work around this problem you can delete the Microsoft-created file MSSCCPRJ.SCC and

then add the project to source control again.

Using ClearCase with Microsoft Word

Release 4.x includes integrations with Word 97 and Word 2000. To use either of these integrations,

do the following:

1. Remove any existing user-defined integration package with ClearCase and Word from the

system. If this is not done, the Release 4.x integration with Word may not install properly.

2. Run the ClearCase Word Integration configuration program; click Start>Programs>

ClearCase Administration>Microsoft Word Integration Configuration. Note that Word 97

or Word 2000 must be installed before you run the configuration program for it to take effect.

3. If you have Word files stored under ClearCase control in a pre-4.0 VOB, follow the steps

described in Using the Integration with Pre-4.0 VOBs on page 58.

Removing a User-Defined Integration

A user-defined integration, if it exists, is encoded in a Visual Basic script file with the extension

.dot, located in the Word startup directory. To find the Word startup folder, follow these steps:

1. In Word, click Tools>Options.

2. In the Options dialog box, click the File Locations tab.

3. Double-click the Startup item on the list to open the Modify Location dialog box.

4. Right-click in the large list box in the center of the dialog box (the list box may be empty) to

display the shortcut menu. Click Explore to start Windows Explorer. In Word 2000, the

startup folder is displayed in the Folder name box in the dialog box.

Windows Explorer is rooted in the Word startup folder.

To remove a previous integration, remove the .dot file associated with it from your Word startup

directory, or rename the file to have a different extension.
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Using the Integration with Pre-4.0 VOBs

To use the Microsoft Word integration with Word file elements in a VOB created using a pre-4.0

release of ClearCase:

1. Install Release 4.2 on the VOB server and change the feature level of your VOB (using the

cleartool chflevel command) to include the new element type. The correct feature level is 2.

For more information, see Guidelines for Using Feature Levels on page 72.

2. Create the ms_word element type in the VOB. After you’ve finished this step, all new Word

documents created in this VOB are created as the correct element type.

3. Convert existing elements created from Microsoft Word files to the ms_word element type.

Using the Tracing Mechanism

The Microsoft Word integration supports a tracing mechanism that can be used to help diagnose

certain problems. Enable it by creating the DWORD registry key

HKEY_CURRENT_USER\Software\Atria\ClearCase\CurrentVersion\Word\Tracing Enabled
and setting it to 1. You can leave the key in the registry when not in use by setting the value to 0.

The tracing is in the form of message boxes that open immediately before commands such as

Check Out or Check In are issued. This can be useful in determining the pathname of the

document, or the name of the command that is about to be issued.

Note that the registry key is checked at Word startup, so changing it during a Word session has

no effect unless you stop Word and restart it.

Deleting the ClearCase Menu Bar

If the ClearCase menu is somehow deleted and the attached template is then saved, that

document, and any document subsequently opened using that template, loses access to the

menu. This happens because menus and toolbars are modified in documents in Microsoft Word,

not in the application.The ClearCase integration adds the ClearCase menu to the Word template

file.

If you delete the menu, you can restore it by using the following procedure:

1. Open the document or affected template.

2. Click Tools>Customize, and click Menu Bar. That is, select the line by that name in the list

control; do not simply select or clear the check box.
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3. Click Reset.

4. Select the affected template file and click OK. Then close the Customize dialog box.

Microsoft Word Terminates Abruptly When ClearCase “SaveAs” is Initiated

If you use ClearCase Release 4.x, we recommend that you not initiate an Add to Source Control
operation from the menu that appears when you right-click in the SaveAs dialog box in

Microsoft Word. This may cause your Word application to terminate abruptly, and could

possibly cause data loss.

Using ClearCase with Sybase PowerBuilder

Using the ClearCase integration with PowerBuilder requires some configuration steps. In

addition, there are some differences between the integration with PowerBuilder 6.x and

PowerBuilder 7.x.

Applying Patches to PowerBuilder 7.x

Before using the ClearCase integration with PowerBuilder 7.0 to 7.02, apply the latest

PowerBuilder patch available for the file PBSCC70.DLL. You can download this patch from the

Sybase FTP site at ftp://psaftp.sybase.com/pub/private/pbpatch/pb701.weekly/202861.zip. This

patch is not needed for PowerBuilder versions later than 7.02.

Enhancing the ClearCase-PowerBuilder Integration

Use the following procedure to add a Help button to the ClearCase integration with

PowerBuilder. After the integration is configured, PowerBuilder displays an icon on its toolbar

for ClearCase Help.

1. Start PowerBuilder

2. Right-click the Powerbar (where the icons are located); on the menu, click Customize.

3. Select your icon by clicking the Custom option.

4. Select an icon, drag it to the Powerbar, and position it as desired relative to the other icons

on the bar.

5. To separate the ClearCase Help button from others on the Powerbar, use one or more

separator icons (located in the left corner of the set of possible icons).
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6. After the new icon is positioned, a dialog box prompts you to enter the command line to be

associated with the icon, as well as text to represent the icon in the Microhelp and when the

cursor is positioned over the icon. Set the command line to the value winhlp32.exe
ccase-home-dir\bin\ph_int.hlp. Set the values of the Item Text and Item Microhelp boxes to

ClearCase Help.

7. Click OK to finish the configuration.

ClearCase Integration Differences: Version 6.x and 7.x

New PowerBuilder 7.x functionality is reflected in the following differences between the

ClearCase integrations with PowerBuilder 6.x and with 7.x.

➤ In 7.x, the Source menu includes the command Add Objects.

➤ In 7.x, there is no Source>Create New Release command; that functionality is provided by

Library>Create.

➤ In 7.x, when you open the Configuration dialog box by clicking Source>Configuration, and

then click Advanced, ClearCase displays an Activity option if your VOB is set up for UCM

development.

4.6 Integration with Rational Rose: Migrating to Release 4.x

ClearCase Release 3.2.1 with patch clearcase_p3.2.1.NT-10 provides the type manager

mechanisms necessary to integrate with Rational Rose. You must configure the integration

manually.

ClearCase Release 4.x provides more direct support for Rose VOB element types. The type

manager _rose and the element type rose are predefined. You do not need to configure Release

4.x because Rose type manager operations (for example, Diff, Merge) work as intended.

Release 4.x provides the standard text diff/merge for the _rose type manager. When the Rose

product is installed, the install program modifies the type manager configuration to use the

Model Integrator diff/merge instead.
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Migration Issues

The Release 3.2.1 integration procedure defines an element type called rose_unit. ClearCase

Release 3.2.1 assigns the element type rose_unit to a new file element that has a Rose extension

(such as .mdl, .ptl, .cat).

ClearCase Release 4.x includes a predefined VOB element type, rose. When you upgrade

ClearCase servers to Release 4.x and raise the VOB family feature level to 2, the rose element type

is available to ClearCase clients that have been upgraded to Release 4.x. New file elements that

are created with Rose extensions are assigned the rose element type.

We recommend that you upgrade all ClearCase clients to Release 4.x at the same time. If your

ClearCase client is running Release 3.2.1, new file elements that are created with Rose extensions

are assigned the element type rose_unit even if the VOB server has been upgraded to Release 4.x.

NOTE: Upgrading ClearCase from Release 3.2.1 to Release 4.x and raising the feature level to 2

does not redefine or overwrite any user-defined element types that were created in a given VOB.

If you created an element type called rose in a VOB at feature level 0 or 1, you must rename the

rose element type before you can raise the VOB family feature level to 2.

If you used the Release 3.2.1 integration procedure, you will have two different element types for

Rose elements after you upgrade to Release 4.x and raise the VOB family feature level to 2. The

ClearCase type manager handles this situation. Both element types can coexist because they both

use the _rose type manager. The mapping of file extension to element type is handled by the

ClearCase default.magic file on ClearCase clients. The 4.x version of this file has mappings for

both the rose and rose_unit element types, and all type manager operations work with any

element type combination that can exist in a VOB.

After you upgrade ClearCase servers to Release 4.x, raise the VOB family feature level to 2, and

upgrade all ClearCase clients to Release 4.x. We recommend that you then use cleartool chtype
to change all file elements with the rose_unit element type to the rose element type. You can then

remove the rose_unit element type from all unreplicated VOBs. You cannot remove element

types from replicated VOBs, but you can run the following command at the master replica of the

rose_unit element type to ensure that the rose_unit element type is not used inadvertently:

cleartool lock –obsolete eltype:rose_unit

Table 13 shows how the elements differ in the Rational Rose integration with ClearCase Release

3.2.1 and Release 4.x.
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4.7 Diff Merge Issues

Several issues exist with the Diff Merge tool.

Diff Merge Tool Does Not Display Multibyte Characters Correctly

The Diff Merge tool does not display multibyte characters correctly.

Workaround:

1. In Diff Merge, click Tools>Options.

2. Click Change.

3. Change the font to one that displays multibyte characters correctly on your machine.

Table 13 Differences in Release 3.2.1 and 4.x Rose Integrations

Release 3.2.1 Release 4.x

Rose element types rose_unit rose and rose_unit

Type manager _rose _rose

Rose entries in default.magic Added by the Rose install

program

Contain entries for rose and

rose_unit

Rose entries for type

manager _rose
Added by the Rose install

program

Predefined

Element type rose_unit Created by the user in the

VOBS

Predefined
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Number of Lines in Compared or Merged Files

Files that are compared or merged with the ClearCase Diff Merge tool on Windows 2000 must

not have lines that exceed (approximately) 3 KB. Some font sizes may increase that limit to

approximately 4 KB.

Some Diff Merge Customizations May Be Lost

The name of the marker for unaltered text in a Diff or Merge contributor pane was previously No
Change in the Options dialog box. The new name is Unchanged. This changes the registry

slightly; the text shown in the list box (in this case No Change or Unchanged) is the actual

registry key under which the font characteristics (for example, color, bolding, italic) are stored.

As a result, any lines marked Unchanged revert to the application's default for that type of

marker. Any modifications that the user may have made, for this marker only, revert to the

default. Modifications for all other marker definitions are retained.

Useful Registry Settings for Diff Merge Tool

There are useful registry settings in

HKEY_CURRENT_USER\Software\Atria\ClearCase\CurrentVersion\Diff Merge that cannot be

set through the GUI. To change these settings, exit all Diff Merge sessions before changing the

registry. If you do not, the values entered manually are overwritten when Diff Merge exits.

Tab size is a numeric value that determines the number of characters a tab character occupies.

The default value for this key is 8. If you set Tab size to 0 or less, it is overridden with 8 and is

saved on exit.

Colorbar scaling factor sets the width of the color density bar in the Diff Merge tool as a

percentage of the width of the vertical scroll bar. For example, if this value is 100, the two bars

are the same width. If the value is 50, the color bar is half the width of the scroll bar. The default

value for this key is 75. If you set Colorbar scaling factor to a negative value, a value of 0 is used.

A Colorbar scaling factor of 0 hides the colorbar.
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4.8 Guidelines on Using the XML Diff Merge Tool

This section notes restrictions and special issues involved in using the XML Diff Merge Tool.

Restrictions on the Tool

As of Release 4.0, use of the XML Diff Merge tool is subject to the following restrictions as a result

of its use of Version 1.0 of the XML expat parser:

➤ All entity declarations for entity references must be within the document; in other words,

the constructs specified by the standalone="no" document declaration are not supported.

(See the XML 1.0 Recommendation Standalone Document Declaration and Entityref
sections (especially Well-Formedness Constraint: Entity Declared) for more information).

If an entity (other than the predefined entities) is not declared, a parser error message

appears on input. In this case, input processing of the document stops, but the application

proceeds.

Files referred to within the input file, by means of SYSTEM declarations, are read to find

externally defined entities, but XML document content defined in these files is not

interpolated into the document.

➤ There is no validation of XML documents, because the parser we use is not a validating

parser. On the other hand, the tool tests for well-formedness; it issues an error message and

exits upon traversal of a document that is not well formed.

➤ Because the parser only parses the internal DTD subset, rather than parsing an external

DTD associated with an XML file, it does not handle documents that depend on the

resolution of parameter entity references.

➤ There is no support for Unicode (UTF-16); the parser converts all the input encoding (for

example, ISO-8859-1) to UTF-8 output.

In addition, the following restrictions also apply:

➤ There is no support for editing element attributes or PCDATA; users must make a choice

between contributors to resolve conflicts, rather than modifying the result.

➤ There is no support for attribute-granularity merges; users must pick an element with all its

associated attributes from a single contributor, rather than selecting some attributes from

each contributor.
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➤ The choices you make in merging different versions of an XML document are inherited

hierarchically. That is, when you select an element to be included in a merged file, all the

children of that element are selected as well. You cannot select an element from one

contributor, and then replace a child of that element with the content of that child in a

different contributor.

➤ Users cannot change or undo any choices made during the course of a merge; that is, you

cannot alter an insertion, change, or deletion after you have selected it.

➤ Color customizations for the XML Diff Merge tool are controlled by the settings for the

ClearCase text mode Diff Merge. You cannot customize the colors directly from the XML

Diff Merge GUI; you can, however, affect colors in this GUI by modifying the colors used

for text mode Diff Merge.

➤ The tool does not support the merge –query and merge –qall options. See the merge
reference page for a description of these options.

➤ In the output file generated by the tool, nonterminal white space formatting is lost.

However, PCDATA white space is preserved.

➤ The tool does not support the empty element tag syntax for output. Files containing <tag/>

constructs are parsed correctly, but the output is of the equivalent form <tag></tag> .

➤ The XML Diff Merge tool displays characters correctly only if they can be represented by a

single 8-bit byte. An extra character appears if you merge an XML file that contains an

ASCII key higher than 127. Characters that require two or more bytes, such as UTF-16

characters and some UTF-8 characters, do not display correctly. Although XML Diff Merge

accepts XML input in any of four encodings (ASCII, ISO-8859, UTF-8, UTF-16), the merged

output file is always encoded in UTF-8. Therefore, we recommend using only ASCII or

UTF-8 encodings for XML elements that may be merged.

➤ When merging XML files, if one contributor version has an XML declaration node, and one

or more contributors do not have a declaration node, other nodes between the declaration

node and the root node can go missing.

To work around this problem, make sure that all versions contain an XML declaration node.

An example of an XML declaration node is as follows:

<?xml version=“1.0”?>

➤ The XML Diff Merge tool does not process the -to switch properly. The –to switch specifies

the name of the merged output file, and the name of a merge contributor. XML Diff Merge

does not set the merge output name from -to; it prompts the user because it does not have a

file name for the merge output.
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Workaround: Enter the -out switch on the command line:

cleartool merge -graphical -to myfile.xml -out myfile.xml myfile.xml@@\main\LATEST

To specify a merge output file name while using the tool, you can also click File>Save.

Ordering of Files in GUI May Need Adjustment

If two or more contributors insert elements and these insertions are adjacent, the desired

ordering in the merge output can be ambiguous. For example, it may not be possible for the tool

to determine whether an insertion from contributor A should appear before a corresponding

insertion from contributor B.

If the element ordering is ambiguous at a given merge point, the one that the tool choose may

not be the one you want. Review all changes in the merge output to confirm desired ordering.

Checking Your Results

In a number of cases, the XML Diff Merge tool cannot evaluate a changed element correctly.

Instead, changes to a single element are reported as the deletion of one element and the addition

of an identically named element. Because of this limitation, we strongly recommend that you

verify comparisons and merges done using the XML tool with the text version of the Diff Merge

tool. We provide a button on the XML Diff Merge toolbar to enable start of a textual Diff Merge.

XML Diff Merge Functionality Note

When merging two XML files, after selecting one of two alternative elements from the

contributor panes effectively deletes the unselected element. As a result, all children of the

deleted element are deleted as well and cannot be selected on succeeding merges.
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Creating Elements of Type xml and Creating New Versions of XML
Elements

The xml element type is based on the text_file_delta type manager. It expects XML elements to

be text files. A text file is assumed to have lines no longer than 8,000 characters each, and no

character may be a binary \000 (null) character.

ClearCase reports an error while creating an XML element or while checking in a new version of

an existing element if the XML data does not look like a text file. If your XML data has more than

8,000 characters between line-terminating characters, its lines are too long for the text_file_delta
type manager. If your XML data is encoded with multibyte characters, it appears to have binary

\000 characters when viewed as a stream of bytes.

To overcome these restrictions, use the file element type to store such XML data. The file element

type can store any type of file and does not have the same restrictions as the xml element type.

To compare and merge XML data that is stored as file element types, you need to invoke the XML

Diff Merge tool directly. See Invoking XML Diff Merge Directly.

If you cannot create a new version of an element of type xml:

1. Cancel the checkout and save your checked-out data in a .KEEP file. For example:

cleartool unco –keep file.xml

2. Change the element type from xml to file by using the cleartool chtype command.

3. Check out the file.

4. Copy the .KEEP file to the checked-out file.

5. Check in the file.

Invoking XML Diff Merge Directly

To run XML Diff Merge directly:

1. Make sure the ccase-home-dir\bin directory is in your path.

2. Issue the xmldiffmrg command. For example to compare two versions:

xmldiffmrg –xcompare file1.xml file2.xml
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To merge two or more versions using a common ancestor:

xmldiffmrg –xmerge –out file.xml.merge –base file.xml file1.xml file2.xml

The file names may be version-extended pathnames. You must use the –xcompare and

–xmerge options instead of –compare and –merge, respectively.

4.9 Build Issues

The following sections describe issues with using ClearCase build tools.

Express Builds and Compatibility Between Releases

This section describes the behavior that occurs when you use ClearCase 4.x views with express

builds on ClearCase 3.x clients. For more information on express builds, see Building Software
with ClearCase.

3.x Clients and 4.x Views

Builds on 3.x ClearCase clients always produce shareable DOs, even if you use a view configured

for nonshareable DOs, because 3.x clients do not recognize express builds.

If the view contains nonshareable DOs, you may get errors if you try to access those DOs.

4.x Clients and 3.x Views

Creating or using a view located on a 3.x host from a 4.x client is not supported.

Incomplete Configuration Records for Nonshareable Derived Objects

ClearCase tries to maintain complete configuration records for a derived object, even if you

delete one or more of the derived object’s sub-DOs. For example, you build foo, which uses

bar.obj, and then delete bar.obj. Even if the sub-DO does not exist, you can still use the catcr
–recurse command on foo to see how it was built.
68 ClearCase and MultiSite Release Notes



However, this may not be true for a nonshareable DO with shareable sub-DOs. If you delete one

of the shareable sub-DOs, the config record for the nonshareable DO is incomplete.

There are two ways to build a nonshareable DO that uses a shareable sub-DO:

➤ Set your view’s DO property to shareable DOs and build a sub-DO. Then, set your view’s

DO property to nonshareable DOs and build a DO that uses that shareable sub-DO.

➤ Set your view’s DO property to nonshareable DOs, and build a DO that winks in a

shareable sub-DO.

The DOs can be in the same or different VOBs.

When the catcr, clearmake, and winkin commands encounter a nonshareable DO with an

incomplete config record, they behave in the following ways:

➤ catcr suggests a rebuild.

➤ clearmake rebuilds nonshareable DOs with missing sub-DOs.

➤ winkin –recurse run on nonshareable DOs with missing sub-DOs prints errors, but does

not fail.

To avoid problems resulting from incomplete config records, do not manually delete sub-DOs of

nonshareable derived objects. Also, if you use makefiles and build tools (for example, C++

compilers that update a repository) that appear to delete sub-DOs in the course of a build, use

the workarounds documented in Building Software with ClearCase.

clearmake Cannot Evaluate Directory Changes During Config Lookup

When you list a directory as an explicit dependency of a target, clearmake does not rebuild the

target if the directory version changes.

4.10 Guidelines on Using the Administration Console

Use the following guidelines when using the Administration Console.
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Accessing the ClearCase Customer Web Site from the Console

To access the ClearCase Customer Web site from the Administration Console, you must first set

up your Microsoft Internet Options. You can do this either when you first install and configure

Microsoft Internet Explorer, or manually using Control Panel>Internet Options. If these options

(for example, firewall and proxy server settings) are not set up, the following message is

displayed when trying to connect to the ClearCase Web site:

Internet Explorer cannot open the Internet site http://clearcase.rational.com.
A connection with the server could not be established.

Refresh Toolbar Button May Vanish, Resizing a View-Private File’s Column
Headers

While displaying a view-private file in the ClearCase Administrator’s Console, resizing its

column headers or displaying the shortcut menu causes the Refresh toolbar button to be hidden.

If this happens, click Action>Refresh action or right-click Refresh.

4.11 Domains Removed from a Trust List Cause Problems When
Using VOB Schema 53

This note applies only to VOBs using the VOB schema 53, not to VOBs formatted using the

schema (54) provided with Release 4.0.

You can change the contents of a domain's trust list with the User Manager for Domains, but the

contents of a domain's trust list rarely change. Because of the way ClearCase implements

security, removing domains from a domain's trust list can invalidate ClearCase security

information. Restoring a removed domain to a trust list does not fix ClearCase's security data.

More specifically, if the domain you remove from a trust list contains ClearCase user accounts or

computers that use ClearCase, then ClearCase protection errors may result. Symptoms of these

errors are as follows:

➤ Certain operations, such as checkout, may fail.

➤ ClearCase may print numeric values when you expect user names.

To display user and group information, use the creds command.
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Because of these potential problems, we recommend that you avoid removing domains from a

domain’s trust list. If a domain is removed from a trust list, contact Rational Technical Support

for information on how to correct ClearCase's security information.

4.12 Print Preview for ClearCase Doctor Is Unavailable

The Print Preview command was removed because it was not functioning properly.

4.13 Error Opening config_spec During View Startup

At view startup, more than one process may need to access the view’s configuration files. Prior

to Release 4.2, the sharing mode used to open these files was too restrictive, resulting in

occasional failures when trying to access these files. For Release 4.2, the sharing mode was

adjusted so that all processes are granted the access they require.

4.14 Problems When Administrative VOBs Are Unavailable

Release 3.x introduced the concept of the administrative VOB, which is used by one or more

other VOBs as a central repository of global type objects. See the type_object reference page for

a description of this feature.

ClearCase users may see errors when the administrative VOB is unavailable. Following are

examples of situations when this may happen:

➤ A user attempts to attach a version label, using a label type that was previously created

automatically, as a local copy of a global label type. The ClearCase mklabel command tries

to contact the administrative VOB that contains the global label type. If that administrative

VOB is unavailable, the mklabel command fails.

➤ A VOB backup script attempts to lock the entire VOB object of \vobs\proj\proj before

copying data to tape. For each administrative VOB used by \vobs\proj\proj, the

ClearCase lock command tries to contact the administrative VOB. If any administrative

VOB is unavailable, the lock command fails, which causes the backup script to fail.
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To disable the above checking for a particular ClearCase command (for example, to keep

working while an administrative VOB is offline):

1. Log on as administrator.

2. Set the environment variable CG_PROCFLAGS to the value no_process.

a. Open the System Control Panel.

b. Click the Environment tab.

c. Set the user variable CG_PROCFLAGS to the value no_process.

3. Execute the command.

4.15 Guidelines for Using Feature Levels

Follow these guidelines to determine when and how to use feature levels:

➤ If you have no existing VOBs on server hosts on which you will be installing Release 4.x,

feature levels are irrelevant, and you can skip the rest of this section.

➤ The primary purpose of feature levels is to manage VOBs that are replicated (using

ClearCase MultiSite) across server machines that are not running the same ClearCase

release. For instructions on using feature levels in this context, see ClearCase Feature Levels in

ClearCase MultiSite Manual.

After you install Release 4.x on a host where a 3.x VOB resides, all 4.x functionality becomes

available except the following:

➤ UCM, including element-type merge behavior (see the mkeltype reference page)

➤ The element types xml, html, rose, ms_word and their associated managers

➤ The following operations on global types:

➣ rename
➣ mkbrtype –replace
➣ mklbtype –replace

➤ The following MultiSite features:
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➣ Adding a file or directory to source control and assigning mastership of all newly created

branches to the current replica

If the VOB family is at feature level 1, you can assign mastership of only the main branch

of a new element to the current replica.

➣ Nonmastered checkouts

➣ Requesting mastership of a branch

For unreplicated VOBs, all Release 4.x features are available after you raise the 3.x VOB’s feature

level to 2. For replicated VOBs, all Release 4.x features are available after you raise the VOB

family’s feature level to 2.

See Chapter 7, Setting Up VOBs in Administering ClearCase for details on raising the feature level

of an unreplicated VOB.

4.16 Restrictions on VOB Schema in Release 4.x

As of Release 4.0, there are a number of restrictions on the use of the larger VOBs created using

the new extended VOB functionality (VOB schema 54):

➤ reformatvob –rm may not completely remove an old VOB database directory during the

load phase of the reformat operation. If the reformat cannot be completed because there is

not enough disk space on the host, remove the old VOB database directory manually. This

directory has a name of the form VOB-storage-directory\db.reformat. After you remove this

directory, run reformatvob –load.

➤ reformatvob uses the space command to calculate the amount of space needed for a

reformatting operation. This fails for large database files, although the failure does not

cause the reformat itself to fail.

➤ The space command cannot successfully run the stat() routine on large database files. As a

result, the cleartool space –vob –generate command can fail. This, in turn, can cause the

Standard ClearCase Daily Tasks task, supported as part of new administration

functionality in Release 4.0, to fail. If you have a VOB with large database files, the failure of

the space command is repeated nightly on scheduled jobs.

To avoid this problem, edit the scheduled job list so that it runs only on VOBs that do not

have large database files. You can do this by modifying the Daily Vob Space task on the

MMC console Properties sheet.
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4.17 4.x Converters Are Incompatible with Previous Releases

As of Release 4.0, the converter file format was changed. If you need to use the clearexport and

clearimport utilities to migrate source files to ClearCase control, you must use a 4.x version of

the converter executables.

4.18 ClearCase Client/Server Requirement for Creating Storage
Directories

ClearCase client systems can only create view or VOB storage directories on a ClearCase server

system running the same release of ClearCase. For example, a ClearCase client system running

Release 4.x cannot create a view or a VOB storage directory on a system running Release 3.2.1.

4.19 ccperl4 Is Discontinued in ClearCase Releases

As of Release 4.1, we no longer distribute ccperl4. The ccperl4 tool was introduced in Release 3.0

to provide backward compatibility with earlier ccperl executables. Release 4.0 is the last version

in which we distributed ccperl4.

4.20 Changes to Names of Trigger Environment Variables

In Release 1.1, a number of trigger environment variables were renamed. In Release 4.2, support

for the old names was removed. Table 14 lists the old and new names.

Table 14 Old and New Names for Environment Variables  (Part 1 of 2)

Old name New name

CLEARCASE_ATTACH_LIST CLEARCASE_ATTACH

CLEARCASE_ATTR_VAL CLEARCASE_VAL

CLEARCASE_ATTR_VAL_TYPE CLEARCASE_VTYPE
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4.21 History Browser Produces Extremely Small Text on Japanese
System

By default, the font used for text and captions in the History Browser is 6-point type. As a result,

output in the History Browser on a Japanese language system is very hard to read.

CLEARCASE_ATTYPE_NAME CLEARCASE_ATTYPE

CLEARCASE_BRTYPE_NAME CLEARCASE_BRTYPE

CLEARCASE_CHECKIN_FROM_PNAME CLEARCASE_CI_FPN

CLEARCASE_ELTYPE_NAME CLEARCASE_ELTYPE

CLEARCASE_FROM_VOB_PNAME CLEARCASE_FVOB_PN

CLEARCASE_FROM_XPNAME CLEARCASE_FXPN

CLEARCASE_HLINK_FROM_TEXT CLEARCASE_FTEXT

CLEARCASE_HLINK_TO_TEXT CLEARCASE_TTEXT

CLEARCASE_HLTYPE_NAME CLEARCASE_HLTYPE

CLEARCASE_LBTYPE_NAME CLEARCASE_LBTYPE

CLEARCASE_NEW_TYPE_NAME CLEARCASE_NEW_TYPE

CLEARCASE_OBJ_IS_FROM CLEARCASE_IS_FROM

CLEARCASE_OUT_PNAME CLEARCASE_OUT_PN

CLEARCASE_PNAME CLEARCASE_PN

CLEARCASE_TO_VOB_PNAME CLEARCASE_TVOB_PN

CLEARCASE_TO_XPNAME CLEARCASE_TXPN

CLEARCASE_TRTYPE_NAME CLEARCASE_TRTYPE

CLEARCASE_VOB_PNAME CLEARCASE_VOB_PN

CLEARCASE_XN_SUFFIX CLEARCASE_XN_SFX

CLEARCASE_XPNAME CLEARCASE_XPN

Table 14 Old and New Names for Environment Variables  (Part 2 of 2)

Old name New name
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Workaround: Click View>Options>Display>Fonts and select a larger font.

4.22 Change to Behavior of Keep checked out Check Box

If you selected this check box in previous releases, the view-private file that you added to source

control would remain checked out. This behavior is consistent with that of the cleartool mkelem
command. As a result, you could lose the contents of this file before it was truly part of the VOB.

This was most likely to happen if you canceled the checkout.

At Release 4.2, the file is checked in and checked out. You can continue working on the file, but

its contents at element-creation time are preserved, even if you cancel the checkout.

4.23 Do Not Change VOB/View Storage Directory ACLs on NTFS File
Systems

On NTFS partitions, each ClearCase VOB or view storage directory has an access control list

(ACL). Modifying the ACL in any way can render the VOB or view unusable.

Because the standard Windows NT file-copying tools (and some backup utilities) do not preserve

file and directory ACLs, use the procedures in Administering ClearCase to copy, move, or restore

a VOB or view storage directory.

4.24 NFS Client Issues

The following sections describe issues with various NFS clients.

Some Commands Need NFS or SMB Access to VOB Storage Directories

The following commands require NFS or SMB access to the VOB storage directory when it

resides on a UNIX host:

➤ lsvob –storage
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➤ mkpool
➤ mktag
➤ register
➤ rename (pools)

➤ unregister

Do Not Enable Automatic Mounting of NFS Directories

In NFS products with UNC support, do not enable automatic mounting of NFS-storage

directories. If you enable automatic mounting, you may experience problems starting views and

VOBs located on UNIX hosts.

4.25 Restart After Changing ClearCase Registry Server

Some ClearCase operations may not work correctly after you change your default registry server.

Some symptoms include ClearCase shortcut menus that do not appear correctly or source

control operations that fail in Microsoft Visual Studio. We recommend that you shut down and

restart your computer after changing the registry server.

4.26 Dynamic Views Do Not Support Microsoft Access Databases

Because dynamic views do not support DOS sharing modes, do not use a Microsoft Access

database from a dynamic view.

Microsoft Access uses a lock file (identified by the .ldb extension) to arbitrate access to the

database. When a client accesses the database to read or to write, it creates the .ldb file. When a

client stops accessing the database, it attempts to delete the .ldb file. In a file system that supports

DOS sharing modes, such as a native Windows file system, if other clients are accessing the

database, the .ldb file cannot be deleted.

In a dynamic view (which uses the MVFS, or multiversion file system), the .ldb file can be deleted

by any client, so that the next client to open the database creates and uses a new .ldb file, which

exposes the database to multiple writes to the same records. For more information on the MVFS

and its known limitations, refer to Administering ClearCase.
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Workaround: Use Microsoft Access databases only from snapshot views located in a file system

that supports DOS share modes (such as a native Windows file system).

4.27 No Built-in Support for Shipping Server-Only Installation

The installation procedure on Windows NT for ClearCase does not automate a MultiSite

shipping server-only installation. For more information on how to accomplish this, contact

Rational Technical Support.

4.28 Dual-Boot Installation Failure

When installing ClearCase in Windows NT on a dual-boot computer (Windows NT and

Windows 98), the installation encounters an assertion failure.

At the beginning of the installation, an error message appears stating something like this:

Assertion failed!
Program: path-name
File: file-name
Line: line-number
Expression: "Function not implemented: " ...
For information on how your program can cause an assertion failure, see the
Visual C++ documentation on asserts.
(Press Retry to debug the application – JIT must be enabled.)

The message box contains three buttons: Abort, Retry, and Ignore.

Workaround: Follow this procedure to complete the installation:

1. Abort the installation (click Abort in the message box).

2. In the Windows NT registry, set the following registry key to 0:

HKEY_CURRENT_USER\Software\Microsoft\Windows NT\CurrentVersion\
WinLogon\ParseAutoexec

3. Reinstall ClearCase.
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4.29 Creating VOBs and Views on Windows 2000 Hosts

On Windows 2000 hosts, VOBs and dynamic views must be created with the storage directory

on a partition that has a drive letter assigned. If the VOB or view storage is on a Windows 2000

mounted drive, local clients will not be able to access the VOB or view.

4.30 DDTS Integration Uses Wrong Environment Variable

The DDTS trigger scripts use the CLEARCASE_PNAME environment variable, but this environment

variable is not set. Instead, the CLEARCASE_PN environment variable is set to the correct value.

The workaround is to set CLEARCASE_PNAME to CLEARCASE_PN at the beginning of each trigger

that uses the environment variable.

4.31 Documentation Issues

The following sections describe problems in the ClearCase documentation.

Problems with Reference Pages

The following problems exist in the ClearCase Reference Manual.

Object-Creation Commands

The reference pages for object-creation commands (chpool, cptype, mkattype, mkbrtype,

mkeltype, mkhltype, mklbtype, mkpool, and mktrtype) do not mention explicitly that the

name specified for an object must not be a valid integer or real number. Be careful with object

names that begin with 0x, 0X, or 0, the standard prefixes for hexadecimal and octal integers.
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clearexport_ffile

-l is an undocumented option for the clearexport_ffile command, which labels the imported

version with the specified label. Existing instances of the specified label are replaced. To use the

option, enter –l label after the –s option.

clearexport_ssafe

The documentation for clearexport_ssafe does not mention that labels on directories in

SourceSafe are not exported.

clearmake

In this release, clearmake is supported in ClearCase LT, but the clearmake reference page does

not list ClearCase LT in the Applicability section.

config_spec

As of Release 4.0, the config_spec reference page does not document creation and use of config

specs for UCM development.

rgy_backup

The instructions for changing the backup registry server host are incorrect. The correct

instructions are as follows:

1. Modify the rgy_hosts.conf file on the intended backup registry server to include the host

name of the backup registry server as the second line of the file.

2. Execute rgy_backup on the backup registry server. After you do this, the backup registry

server will include current registry information, which it requires to assume the role of the

primary registry server.

3. Modify the rgy_hosts.conf file on each client to be served by the backup registry server, so

that the second line of the file contains the host name of the backup registry server.

rgy_switchover

The rgy_switchover reference page is incorrect in the following ways:

➤ It indicates that the –backup option accepts a list of hosts. This is incorrect. You can specify

only one host.
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➤ The Restrictions section says that you must be a root user to run rgy_switchover. This

statement is untrue. You can be any user. The third example in the reference page is

incorrect. Ignore this example.

➤ The page contains incorrect information about switching registry server hosts. See the

chapter Moving, Renaming, and Backing Up the ClearCase Registry in Administering ClearCase
for the correct procedure.

➤ rgy_switchover can only modify configuration information on hosts on which ClearCase is

running. This means that it is not be able to inform the old primary registry server of the

switchover if the switchover is prompted by failure of the primary server.

➤ The degraded mode referred to in the rgy_switchover reference page does not exist. If a

primary server is unavailable, clients attempting to contact a server fail until the server

becomes available or rgy_switchover is run.

Problems with the ClearCase Product Family Documentation Supplement

The ClearCase File Server chapter of the ClearCase Product Family Documentation Supplement
incorrectly states that Rational supports use of Samba 2.2 with ClearCase. The Samba version

number should be 2.0.7.

In this release, clearmake is supported in ClearCase LT, but the clearmake reference page does

not list ClearCase LT in the Applicability section. Also, Chapter 1 of the ClearCase Product Family
Documentation Supplement states incorrectly that the clearmake reference page does not apply to

ClearCase LT.

Problems with Online Help

If you start help by pressing F1 in an application window (context-sensitive help) and begin a

series of jumps into the online documentation, you may see the error help topic not found ,

when in fact the topic exists. If you click OK in the error message box, the topic then appears.
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Issues with Tutorials

Several issues exist with running tutorials.

Tutorial in Windows Environment

Before users can run the tutorials, the administrator must create view and VOB storage locations.

To verify that this was done, users can enter the following commands on the command line:

➤ cleartool lsstorage –view

➤ cleartool lsstorage –vob

Each command must display at least one registered storage location. If either command does not

display storage locations, the tutorial will not run. The tutorial scripts check for this situation

during the verification step, and report failure.

Tutorials in a Mixed Environment

The ClearCase tutorials cannot be run on Windows client hosts that use UNIX servers. VOB

creation is not supported across heterogeneous network configurations, and all ClearCase

tutorials create private VOBs.
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55 Restrictions and Guidelines for
MultiSite

This chapter contains release notes for Rational ClearCase MultiSite Release 4.2. For information

about previous releases, see Release Information for Older Releases on page 11.

5.1 Change in Display of Packet Expiration Value

If you select the Use Default Expiration check box for a storage class, the value displayed in the

Packet Expiration box is -1. To display the actual value, display the -default class. If you clear

the Use Default Expiration check box, you must change the Packet Expiration value to a number

equal to or greater than 0. Otherwise, the Use Default Expiration check box is selected when you

click OK.

5.2 disprun Utility Will Be Removed in Next Major Release

The at-based mechanism (the disprun utility) for scheduling MultiSite jobs is still included in

this release. However, we strongly recommend that you transition to the use of the new

scheduling mechanism. The disprun utility will be removed in the next major release of

ClearCase. For more information on scheduling synchronization with the ClearCase scheduler,

see the schedule reference page and ClearCase MultiSite Manual.
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5.3 Specifying a Storage Location During Replica Creation

In this release, if you specify the –stgloc option in a mkreplica –import command, the command

verifies that the storage location is on the new replica’s host. If it is not, or if you specify the –auto
option and no registered locations are on the new replica’s host, the command prints an error

message.

5.4 Export Retried if Object Modification Causes a Failure

In previous releases, if a synchronization export operation tried to access an element that was

being modified by a user, the export failed. In this release, the export is retried several times if an

error occurs because an element is being modified. You may see the following messages:

Database identifier (dbid) not found in database: ' dbid'.
...
Retrying this operation. If it succeeds, you may ignore the preceding ’dbid
not found’ error message. If the error occurs again, try the export again.

5.5 Name Change in shipping_server Mail and Logs

The mail sent by the shipping_server and the error messages created in the Windows Event

Viewer now contain the phrase The Rational shipping server  instead of The Atria

shipping server .

5.6 Converting to New MultiSite Scripts and New ClearCase
Scheduler

ClearCase and MultiSite Release 4.0 contained new synchronization scripts and a new method

for automating synchronization. If you are upgrading to Release 4.2 from Release 3.x, follow the

steps in this section to convert from the pre-Release 4.0 scripts and automation mechanism to the

new ones.
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NOTE: If you did not deinstall your old release of MultiSite or if you preserved the old scripts,

your existing jobs continue to work. However, we recommend that you switch to the

scheduler-based method as soon as possible. Note that the disprun utility will be removed in the

next major release.

To convert from at-based automation to scheduler automation, use the following procedure on

each replica host:

1. Make sure you have permission to schedule jobs; you must be on the scheduler’s ACL. See

the schedule reference page.

2. List all import and export jobs and receipt handlers. Import and export jobs are typically

defined as at jobs, and receipt handlers are defined in the MultiSite Control Panel.

3. Determine which new scripts and options you need to use by reading the sync_export_list
and sync_receive reference pages. Table 15 compares the old and new scripts.

4. If you must continue using any scripts in ccase-home-dir\config\cron (or any locally written

scripts located in other directories), follow these steps:

a. Copy the scripts into the directory ccase-home-dir\var\scheduler\tasks.

b. Define tasks for the scripts (except receipt handler scripts) by editing the file

ccase-home-dir\var\scheduler\tasks\task_registry. You must add the new tasks to the

end of the file. For example, the following task is defined for the local script

sync_export_lex.pl:

Task.Begin

Task.Id:       110

Task.Name:     "Sync Export Lexington"

Table 15 Old and New MultiSite Scripts

Old script New script

sync_export.bat sync_export_list –all –quiet 1

sync_export_one.bat sync_export_list –quiet 1 –replicas
replica-name@vob-tag

sync_import.bat sync_receive –quiet 1

sync_poll.bat sync_export_list –poll –quiet 1
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Task.Pathname: sync_export_lex.pl

Task.End

Note that the Task.Id value must be unique.

5. Open the MultiSite Control Panel and update the paths in the receipt handler entries for all

shipping classes.

6. Cancel all import and export jobs run by at.

7. (Optional) Remove all scripts in the directory ccase-home-dir\config\cron. Remove from

their original locations any scripts you copied into ccase-home-dir\var\scheduler\tasks. (Do

not remove scripts from ccase-home-dir\var\scheduler\tasks.)

8. Schedule synchronization jobs:

On the command line:

a. Enter the cleartool schedule –edit –schedule command.

b. Modify the existing MultiSite definitions or create new job definitions. These definitions

can use the MultiSite Sync Export task, the MultiSite Sync Receive task, or the tasks

you defined in Step #b in Step #4.

There are three preconfigured (and disabled) MultiSite jobs: Daily MultiSite Export,
Daily MultiSite Shipping Poll, and Daily MultiSite Receive. To schedule any of these

jobs, remove the line Job.Schedule.LastDate. You can also adjust

Job.Schedule.FirstStartTime, Job.Schedule.StartTimeRestartFrequency, and

Job.NotifyInfo.Recipients appropriately.

c. Save and close the file, and type yes at the prompt Replace the entire schedule?

In the graphical interface:

a. Start the ClearCase Host Administration console and click Scheduled Jobs.

b. Modify the preconfigured MultiSite jobs or create new jobs.

There are three preconfigured MultiSite jobs: Daily MultiSite Export, Daily MultiSite
Shipping Poll, and Daily MultiSite Receive. To schedule any of these jobs, double-click

the job. On the Schedule tab, adjust the Run dates and times appropriately. On the

Settings tab, adjust the notifications appropriately.
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To create new jobs, click Action>New>Job and fill in the fields on each tab. The job can

use the MultiSite Sync Export task, the MultiSite Sync Receive task, or the tasks you

defined in Step #b in Step #4.

c. Click OK in the Job Properties dialog box to save and schedule the job.

For more information, see the schedule reference page in the ClearCase Reference Manual.

5.7 Handling Pathnames That Contain Spaces

If the pathname of a receipt handler or a shipping order contains spaces, DOS “short name”

resolution must be enabled for the file system on which the receipt handler or shipping order is

located. This property is enabled by default. If this property is not enabled, the shipping_server
cannot invoke the receipt handler or process the shipping order.

5.8 Using UCM and MultiSite

The following restrictions apply to use of UCM and MultiSite:

➤ You cannot request mastership of branches in UCM VOBs.

➤ If a UCM component is replicated, its associated UCM project VOB (PVOB) must be

replicated.

➤ You must synchronize a UCM component and its associated PVOB at the same time.

➤ ClearQuest-enabled UCM projects can be replicated and synchronized. In addition to using

ClearCase MultiSite to replicate and synchronize UCM project and component VOBs, you

can use ClearQuest MultiSite (in beta release) to replicate and synchronize associated

ClearQuest user databases. You must synchronize a UCM PVOB and its associated

ClearQuest user database at the same time.
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5.9 Limitation on Use of Magnetic Tape for Packet Transport

Although mkreplica –export and syncreplica –export can divide logical packets into several

physical packets, do not try to place more than one physical packet on a tape. This limitation

exists because mkreplica and syncreplica always write physical packets at the beginning of the

tape. This problem has been reported in CPF change request #CMBU00017624 (old #19829).

5.10 Warning on Receipt of Packet from Earlier MultiSite Version

The packet protocol for MultiSite Releases 4.0, 4.1, and 4.2 is Version 3.0, and MultiSite Releases

3.2.1 and 3.2 are at Version 1.2. When a Release 4.x multitool reads a packet with the older

protocol, it prints this message:

multitool: Warning: Version mismatch, software:3.0, packet:1.2

This message does not indicate a problem. It means one of the following things:

➤ The feature level of the VOB family is lower than the feature level of the receiving replica.

➤ The feature level of the VOB family is the same as the feature level of the sending and

receiving replicas. However, when the sending replica created the update packet, it had not

yet received a packet containing the information about the new VOB family feature level.

5.11 Do Not Use MultiSite to Clone a VOB

Do not use MultiSite to create multiple copies of a VOB in a single ClearCase region. Because the

VOB UUID is identical for all replicas in a VOB family, and is stored in many structures within a

VOB, there is no way to make the copy of the VOB unique. Creating and using multiple copies

of a VOB in a single region causes clearmake and views to exhibit unpredictable behavior, may

cause data loss, and is not supported by Rational Software.
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5.12 Synchronization Error When Database Limit Is Exceeded

ClearCase Releases 4.0, 4.1, and 4.2 include support for a new VOB database schema. If you

update one or more replicated VOBs in a family to the new schema (version 54), you do not have

to update the other replicas in the VOB family immediately. However, you must update all

replicas before one of the updated replicas exceeds the database limit of the previous schema

(version 53). If you do not, replicas that have not been updated will not be able to import

synchronization update packets from the updated replica.

When this type of import failure occurs, syncreplica output includes a VOB database error, and

an error is written to the db log.

The syncreplica output includes an error like the following:

multitool: Error: Error from VOB database: ’’\\vob.setup’’.

The db log includes an error like the following:

09/20/96 10:40:49 db_server(19528): Error: DBMS error in "../db__lock.c" line
79
*** db_VISTA database error -909 - file record limit exceeded
09/20/96 10:40:49 db_server(19528): Error: DBMS error
09/20/96 10:40:49 db_server(19528): Error: db_VISTA error -909

To fix this problem, you must convert all replicas in the family to schema version 54. To display

the schema version for a VOB replica, use the cleartool describe vob:vob-tag command. To

display the schema version of the ClearCase release installed on your computer, use the cleartool
–ver command.

5.13 Limitation on Editing Mastership Request ACL

In this release, you do not have to be logged on to a VOB server host to edit the mastership

request ACL for a replica on that host. However, if you are not already on the ACL, both of the

following conditions must be true in order for you to edit the ACL:

➤ You must be the VOB owner or privileged user.

➤ You must be logged on to a host in the same domain as the VOB server host.
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5.14 Documentation Issues

In this release, the MultiSite Help command is accessible from Start>Programs>Rational
ClearCase Administration>MultiSite Help. The ClearCase MultiSite Manual incorrectly uses

ClearCase Administration in the menu path instead of Rational ClearCase Administration.

5.15 MultiSite Support on Windows Platforms

MultiSite runs on the Windows NT and Windows 2000 platforms. The ClearCase MultiSite
Manual uses the term “Windows” to refer to these platforms.

NOTE: Replicated VOBs on a Windows server can be accessed from any ClearCase client host

running Windows and from UNIX snapshot views.
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66 Status of ClearCase Software
Change Requests

Noteworthy problems found in or resolved in Release 4.2 of Rational ClearCase are listed in the

file cc-issues.htm.

You can find this file in two places:

➤ On your ClearCase CD, in the folder Rational\doc\platform, where platform is an

architecture mnemonic like ux (for UNIX computers) or nt (for Windows computers).

➤ In the folder ccase-home-dir\install\ after you’ve installed the product.

Note that any problems relating to installation or setup of ClearCase are noted in the section

Known Issues Related to Installation in Chapter 1, READ ME FIRST.
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77 Status of MultiSite Software
Change Requests

Noteworthy problems found in or resolved in Release 4.2 of Rational ClearCase MultiSite are

listed in the file ms-issues.html.

You can find this file:

➤ On your ClearCase CD, in the folder Rational\doc\platform, where platform is an

architecture mnemonic like ux (for UNIX computers) or nt (for Windows computers).

➤ In the folder ccase-home-dir\install\ after you’ve installed the product.

Note that any problems relating to installation or setup of MultiSite are noted in the section

Known Issues Related to Installation in Chapter 1, READ ME FIRST.
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